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Warning and Precautions

Electricity can provide many useful functions, but improper use will also cause harm to
personal and property security, both the design and manufacturing of this product are based
on the highest requirements of safety, improper use may cause harm, such as electric shock,
fire damage, etc. To avoid such dangerous, please comply with the following instructions
when users are installing, operating and cleaning. In order to ensure your personal safety and
prolong the service life of the product, please read carefully before start using safety warning
clause.

10.

11.

12.

Read this instruction

Before operating the unit, please read and understand all instructions.

Keep this instruction

Please store this safety and operation instruction in safe place for future use.

Heed all warnings

Please strictly abide by all the safety warning related to this product in this manual.
Heed all warnings

Please strictly abide by all the safety warnings related to this product in this manual.
Follow the instruction

Please follow all instructions.

Accessories

Please use the attachments or accessories designated by manufacturer. Do not utilize
the accessories recommended by illegal manufacturer, otherwise may cause accident.
Power supply

The power supply utilized in this unit is marked on the power supply label. If you are not
sure the power supply type in your area, please consult the local dealer or electric power
company. To better protect the product, in the thunderstorm weather or when this

unit is not utilized for a long time or when unattended for a long time, please unplug
the power plug of this unit and disconnect the antenna, which will help to protect the
product from damaged by lightning or power cord surging When need to utilize this
unit with another type of power supply, please replace the power cord and consult to
local dealer. Power outlet shall be installed in the place where is easy to connect and
close to the unit. Please utilize the power cord designated by the dealer to ensure the
safety and electromagnetic compatibility When the unit is needed to connect with VCR
or computer, please turn off the power supply of this unit to avoid electric shock.
Power cord protection

Please protect the power cord, especially the connection position among plug, socket
and power cord with this unit should not be trampled.

Overload

As for the wall socket and power outlet, do not overload use, to avoid fire or electric
shock.

Objects fell into or liquid splashed into

Don't insert objects from the ventilation hole or the hole of this unit. This unit has high
pressure, the inserted object may cause electric shock or parts short circuit inside the
unit So don't let water drop or liquid spill into the unit.

Maintenance

Please contact maintenance issues to the authorized service personnel. When the unit is
damaged by the followings, the unit is needed to be repaired: the power cord or power
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plug is damaged; liquid splashed into or solid fell into the
unit, the unit is exposed to the rain or damp environment
or the unit is dropped.

. Conditions requiring maintenance

When any of the following conditions occurs, please pull
the plug from the AC socket and contact the professional
maintenance personnel for repair.

a. Power cord or plug damages;

b. When liquid splashed into or solid fell into;

c. When the unit is exposed in rain or water;

d. When do not operate according to the instructions
described in the operation manual; do not carry out
operation not regulated in operation manual, improper
adjustment or setting may cause damage to the unit,

at this time, it needs rectification or adjustment by
professional technical personnel.

e. When the unit falls or the case has any damage;

f. When the unit displays abnormal conditions or
significant changes, which indicates that the unit needs
to be repaired.

Replace parts.

When the product’s parts need to be replaced, please
confirm that the parts utilized by maintenance personnel
is designated by manufacturer, or original parts with
same characteristics and performance. Usage of
unlicensed parts may cause fire, shock and/or other
hazards.

Safety inspection

When maintenance service is completed, please ask
maintenance personnel to check safety performance of
unit to confirm that the unit is under normal state.

. Wall hanging

When the unit needs to be hung on wall or ceiling, please
make sure to install according to the method provided by
the manufacturer. This concerns safety issues.

Holder

Please utilize the wheelbarrow, foot rest, tripod, holder or table designated by
manufacturer or sold with the unit. Do not place it on unstable trolley, holder, tripod

or table. Placing the unit on unstable surface may cause the unit to fall and injure
personnel or damage the product. Please follow the manufacturer’s installation
instructions when it needs to be hung on wall. Please utilize the wall accessories
recommended by manufacturer.

Move carefully

When moving with small cart, please be careful to move the cart and the unit to avoid
the fall of the unit and injuring personnel. Sudden stop, excessive force and uneven
ground may cause the unit to fall from the cart.Do not utilize and move LCD Unit at work
or standby mode.

Lightning strike move 2 nxt page




20.

21.

22.

23.

24.

25.

Please unplug the battery socket of the unit when the unit is not utilized for a long time
or in thunderstorm weather.

For better protection of this product, please unplug the battery socket of the unit and
disconnect the antenna in thunderstorm weather or when the unit is not utilized for

a long time or unattended for a long time. This will help to prevent the damage to the
product caused by lightning or online surge.

Please do not utilize this unit near water source.

For example, near the tub, wash basin, kitchen sink or wash basin; in a wet ground or
near a swimming pool, etc.When moving the unit from a low temperature place to

a high temperature place, water steam will be condensed, do not utilize in this case,
otherwise it may cause fire, electric shock or other hazards.

Please clean with dry cloth.

Please remove the power cord before cleaning, do not utilize liquid cleanser or aerosol
to clean this unit. Please utilize dry cloth when cleaning.

Ventilation opening

Please do not block any open ventilation hole. Please install the unit according to
manufacturer’s instruction. Both opening and ventilation holes in the unit casing are
designed for ventilation. Do not plug these opening and ventilation holes. Insufficient
ventilation may cause overheating and may shorten the service life of the unit.Please
do not place the unit on bed, sofa, carpet or other similar surface, because this will
block the heat emission opening. This product design does not support embedded
installation, unless there is adequate ventilation space or permitted in the manual by
manufacturer, please do not install the unit in confined space, such as bookcases, shelf,
etc.

Heat source

Do not install the unit near heat source such as heater, stove or other heating
equipments (including efficacy).

Screen protection

The LCD screen is made of glass.Therefore, the screen may be broken when the unit
falls or it is compressed by other objects. Be careful to avoid damage when the screen is
broken.

Pixel defects

The LCD screen of this unit is a high-tech product, it can provide fine picture. Sometimes,
some inactive pixels may appear blue, green or red fixed point on the screen, but that
does not affect its performance.

Remarks: when utilizing this product, the product’s power plug must be connected to
the power supply outlet with protective grounding.



1. Product Introduction

1.1 Product Advantages

» Ultra-narrow bezel: awesome videowall configuration;

» Customized stitching: customized matrix control for videowall ;

» Simple split screen: automatic dislocation compensation;

» Multiple controls: RJ45 control port in two modes.

» Excellent control: multi-screen unified screen, enjoy the real big screen;

» High resolution: fine screen resolution, screen zoom freely; Highlight screen: highlight the
screen to show the high quality view;

> Ultra wide Angle: visual range up to 178°, each angle of wonderful view.

1.2 Product features

» the product supports 4K input, and when clicking 4 pieces of 1920 Mosaic screen (3840x2160),
the point-to-point display can be realized, which means that the display screen is not
compressed, and the display effect is clear and realistic.

» the product support DP loop - through, as long as the user input signal randomly, DP can

output loop - through to the next screen DP input port, and this function can replace distributor

and matrix (front signals access is 4 k, which means that it has replaced the 4 k and 4 k dispenser
matrix) part of the function to use (product no longer needs to use signal distributor);

the input signals support a 90-degree, 180-degree, 270 degree flip, and the rollover effect is

excellent.

support machine code (address code), and the line address is easy to recognize, because the

user only needs to fill in the control software;

it has the function of automatic signal detection. When the signal input is detected, it will

automatically switch to the signal source.

v

v

v

1.3 Product specification

Screen Size (Diagonal): 55

Pannel type: ADS

Resolution: 1920 x 1080 (Full HD)
Brightness (cd/m?): 500

Contrast: 1200:1

View Angle (V/H): 178°

Response Time (GtG, ms): 8

Bezel (mm): 35

Input: VGA, DVI-D, HDMI x2, DisplayPort, RJ45 (RS232)
Output: DisplayPort, RJ45 (RS232)
Dimensions (HXWxD, mm): 1214x684x94

Weight (kg): 28

VESA Mount Compatibility: 400x400

Power consumption (W): 171
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1.4 System Connection Mode
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1.5 Common Fault Handling

When the fault occurs, please cut off the power supply immediately. Please do not attempt
to disassemble the machine to repair by yourself, which may cause a further damage. You
can follow the steps below, if you still can not solve the problem, please contact your local
dealer or professional repairing personnel. The products are out of the warranty scope
when users repair them by themselves.

Phenomenon Disposal

1. Check whether the power line is damaged.

2. Check whether the power supply is accessed to electricity.
3. Verify that the power supply has been opened.

4. Check whether the power switch is damaged.

5. Check whether the insurance is fused.

No boot (the power indicator
light does not shine)

1. Check whether the port settings of the videowall software are correct.
2. Check whether there is a damage in the serial line, and whether itis a
good connection between the product and the PC interface.

3. Check whether there is a problem with the PC serial port, you can
change another PC for testing.

4. Check whether the address of the videowall unit is correctly set
according to the address setting instructions.

All the videowall units are
out of control

Some individual videowall 1. Check whether the address of the device are correctly set.
units are out of control 2. Check whether can control a single unit separately.

1. Check whether the interface between the unit board and the signal
source is well connected.

No VGA/DVI input of single 2. Change another VGA/DVI line to test.

or multiple devices 3. Check whether the device is arranged in the corresponding input state.
4. Check whether the input signal is compatible with this product input.
5. For DVl input, confirm the DDC capture and the output.




2. Interface and Dimension
2.1 Interface Specification

P & &= e &= @ @] ()

DViinput HDMI MHL HDMI 4K DP input VGA input DP output RS-232input RS5-2320ut AC INPUT
Port Description

DVl input DVl interface input, Up to 1920x1080 60hz
HDMI MHL HDMI digital signal input, Up to 1920x1080 60hz
HDMI 4K HDMI digital signal input, Up to 3840x2160 60hz
DP input DP digital signal input, Up to 3840x2160 60hz
VGA input VGA analog signal input, Up to 1920x1080 60hz
DP output DP Daisy Chain output, Up to 3840x2160 60hz
RS-232 input . .
(RJ45 jack) serial command input for remote control
RS-232 out . . .
(RJ45 jack) Serial Daisy Chain output for remote control
AC Input Power Supply
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3. PC Control Software

3.1 Running Environment

» System: operating system of Windows98/2000/NT/XP/WIN7/Vista

> The minimum configuration of CPU: Dual core 2.0GHz and above

> Memory: 1GB

> Display card: Standard VGA, 256 color display mode and above

> Hard disk: A typical installation 1T0M

> The serial communication interface: Standard RS232 communication interface or its
compatible model

3.2 Starting the Software

Before running the Software, ensure the following normal connection:
» The RS232 line of the computer for the software is properly connected to the controller.
» Both the relevant signal lines of the controller and power line are connected correctly.
System operation procedure:
1. open the power supply of the controller, the indicator light will light up.
Green stands for a startup state; orange stands for a standby state.
2. operate of the software
Extract the splicing control software RAR, you can get the following files: user logo,
automatically adjust the picture VGA, serial debugging, LCDWall.exe, LcdWall.exe.
manifest, MWS_Cfg.ini. The control software is, no need to be installed. Run the Lcdwall.
Exe, and then it appears as shown in Fig. 1.

Note: All the operations must be open in the serial port
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Fig. 1

Note: The contents of interface may differ from the example shown above with the different
version of the software; You may consult our relevant customer service staff.

The function description of the operation interface is shown in Fig. 1:

» Operation zone: each grid element represents the corresponding controlled screen, you
can select the corresponding controlled unit through the keyboard or the mouse clicking
or dragging.

» Function zone: contains commonly used function buttons.

> User’s title zone: the users can change the displays of the title according to their own
requirements.

» Status zone: displays the port state and the operation authority state, and the current local
time, date, etc.

3.3 Starting the Software

1. Click the function diagram of «serial port settings», the interface is shown as in Fig. 2.
2. Click “refresh”button to mate COM automatically, and then click “open” to achieve
connection.

COM zet

|come |
[~ Auto Open Refresh

Open COM

Fig. 2 -11-



» The rows in «Wall Settings» are set according to the actual needs.
» The following 2X2 in XP for example to explain
» If the splicing wall is 2X2, the splicing array must be set to 2X2, otherwise it will be spliced

incorrectly

3.4 Device ID Setting

All equipment in the factory serial number are 1, the user should set the screen serial
Chinese-English number according to their own needs.

1. Administrator users enter the «Panel ID set» setting

2. For each screen display machine code, fill in the corresponding ID number

3. Click modify to complete the modification of the screen serial number

JEIN s "W

ween OH Sereen OFF Functiog Set Sereen Adde Merge TnMer ge Fresrs

[ Panel ID set

Mac Keyp
Parel Unit (D Charge

Display Mackey | Displey ParellD |

Matrix In: 0
Fig. 3
Note:
» When this function modifies the again number, read the machine code displayed on the
screen and modify the corresponding screen and again number.
» System Settings» button can only be operated after entering the administrator password

» The default administrator password is 111111, which can be modified by yourself, please

keep in mind the modified password.
» The remote control is only useful under the multimedia channel

3.5 Single machine operation

You can choose a single or multiple videowall units to set on/off of the unit(s), and you
canalso right click the mouse to set the input signal, or click on the «Freeze» to freeze the
current image, and click again to cancel the freezing.
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3.6 Merge operation

For multiple videowall units, 2 by 2 for example, after selecting the 4 screen, select the
signal source in the signal sources, click the «execute» button to complete the procedure.
You also can click on the «image freezing» to freeze the current image, and click again to
cancel the freezing.
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After Merge, there will be physical seams between the units, you can select the «eliminate
the border» and set up corresponding values to compensate borders between pictures.
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Note: the border value is set according to the physical dimensions of the screen.
Fig.7 shows the effect of removing frames.

This function of removing frames is not used.  This function of removing frames is used.

Fig.7

3.7 signal source selection

select signal source, and click Execute button
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3.8 Matrix Enable

1. Select: Matrix Enable, and select the matrix input No:
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2. Select the matrix type and configure the matrix ID

Note: different matrix selection has the different time delay
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3.9 Scene Preset

» It supports to save 16 presets of Scene Select whose names can be modified.
» Scene Select to be saved, then click «<Save Scene», and the model is saved.

» The «load Scene» can call the users saved mode.

» The polling mode of the scenes can be started according to user’s needs.
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Fig. 11
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3.10 Software settings

1. Click the Admin button and enter the super Administrator Password 111111 in the pop-up

dialog box.
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Fig. 12

2. Click the Main Set button, and make the following settings in the pop-up dialog box
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Fig. 14

Note: Only the administrator can access the settings.
In this menu, the two options of Video and VGA are set by different signal sources; and
each of the settings in the videowall unit will display correspondingly.

3.10.1 Picture Setting

When Video is selected in Adjust Object, «Brightness», «Contrast», «Color», «Sharpness»,
«Tint», and « Color Restore» can be set.

When VGA is selected in Adjust Object, only «Brightness», «Contrast», and «Color Restore»
can be set.
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Fig. 15
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3.10.2 Geometry adjustment

When Video is selected in Adjust Object, «<HPosition», «<Hsize», «VPosition», «Vsize» can be set.
When VGA is selected in Adjust Object, «<HPosition», «<VPosition», «Clock», «Phase» can be set.
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Fig. 16
Note: ADC Adjust is not available

3.10.3 Color Temp

Whether you choose Video or VGA, you can set the white balance
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Fig. 17

3.10.4 System adjustment

Under the System menu, you can set the machine’s software, including backlight brightness
adjustment, no signal blue and black screen modes, software upgrade, VGA and color
automatic adjustment, etc.
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Professional terminology explanation:

» Backlight: Used to adjust the Led brightness, not related to the signal.

> Auto ADC: When the value captured in VGA state is not correct and the color display is
not normal, click this button to re-capture, can repeat multiple clicks (Note: used in the
videowall unit single screen display).

> Blue Screen On: When clicking this button, the blue screen mode hits, and when there is
no signal, the display is blue screen. Receive a signal signal after normal display.

> Black Screen On: When this button is clicked, the black screen mode is played, when there
is no signal, the display is black screen. Receive signal After the normal display (Note: This
function is more practical in some special occasions such as night clubs).

» Factory Reset: After setting the confusion, you can click this button to restore the unit to
the factory state. (Note; without the manufacturer’s permission, no user reset)

3.10.5 Screen Add
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Fig. 19
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Select Screen Add, pop-up to the picture box as Figure 19.

Fig. 20

All splicing control box in the factory address are 01 01, the user should set the address

according to their own needs

Setting method is as follows:

1. Display the screen machine code, at the bottom of the screen, as shown in Figure 20.

2. Softwere select Screen Add, pop-up to the picture box

3. Set the corresponding screen address, click Modify to complete the modification of the
address

3.10.6 software upgrading

1. Copy the software MERGE.bin to the root directory of the USB stick without changing
the file name.

2. Insert the USB disk into the USB port of the video wall.

3. AsinFigure 21, click on the software upgrade, the screen will become blue, the progress
of software update will be displayed in the upper right corner, and the power indicator
will flash green/orange alternately, and the upgrade will restart automatically after
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Fig. 21

Note: This function in the upgrade process, please do not power off and unplug the USB
disk, otherwise it will damage the machine
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3.10.7 Fan Set

Our video wall is not equipped with fans, this feature is temporarily unavailable

3.10.8 Panel adjustment

Adjustment as shown in Figure 21, it is recommended to have a professional adjust
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3.11 Function Set

1. Click the Admin button and enter the super Administrator Password 111111 in the pop-up
dialog box.
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Fig. 23

2. Click the Funtiog Set button, and make the following settings in the pop-up dialog box
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3.12 Title Set

Click System Settings, and in the pop-up dialog box, click Title Set
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Fig. 26

» Title: Users can modify according to their own needs

» User name: Users can modify according to their own needs

» Company URL: Users can modify according to their own needs, can be changed to any
desired URL

» User LOGO: User can modify any company LOGO here, then OK
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Note: Open the control software click on the bottom left corner of the LOGO image area,
according to the user has set up a LOGO, URL, etc. click Open it will be connected to the set
URL

3.13 Language
Customers can choose language for software
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4, RJ45 to interface line sequence
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Fig. 28
TX,RX,GND->2,3,5
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5. Remote Controller

5.1 Remote Controller

Fig. 29

5.2 IR Receiver

IR Receiver have to be insert on the no. 1 screen of the daisy chain via RJ45 IN port, otherwise
you have to insert to each screen one by one

5.3 Screen Address Setting

1. Press «sMENU» on remote controller, below OSD will pop up:

Input HDMI2
Brightness 100
Contrast 100
Backight 100
Saturation 98
Sharpness 2
Volume 50

4 9 < D>

Fig. 30

Refer to input source in use, select «input». For example, if kHDMI2» is in use, just move to
«input» by «up» and «down» button, set to «<HDMI2» by «left» and «right» button, then press
«MENU» to save changes.
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2. Move to «<MachineCode» page by «left» and «right» button on <MENU» OSD.

Machine Code 26047
Ten Thousands 2
Thousands 6
Hundred 0
Ten 4

4 9 < D

Fig. 31

Refer to the No. of «MachineCode», set «Ten Thousands», «<Thousands», «<Hundreds», «Tensy,
«Ones» , then press <MENU» to save changes.

3. Move to «video wall matrix setting» page by «left» and «right» button on «<MENU» OSD.

Unit ID 1
Merge Mode

Start Row 1
Star Col 1
Start Row 2
Star Col 2
Counter Row 2
Counter Col 2

4 9 < >

Fig. 32

Set video wall matrix setting. For example, if you want to set up 2x2 matrix, then set

«Start Row» to «1», «Sart Col» to «1», «kEnd Row» to «2", «End Col» to «2», «Counter Row» to
«2», «Counter Col» to «2». «Unit ID» is current screen matrix location No., set «Unit ID» to
corresponding No., then Set «<Merge Mode» to «Merge», Press «<MENU» to save changes. If you
want to exit video wall matrix mode, then set «<Merge Mode» to «Normal».
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Company Name: Malead Limited. Company address: Flat/Rm 9, 25/F Concordia Plaza, 1 Science
Museum Road, Tsimshatsui, Kowloon, Hong Kong.

Material: plastic, metal.

Warranty: 36 months.

Made in China.
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3axoaun 6e3nekun

YBaXkHO NpoumnTaiTe Lo iHCTPYKLito 3 eKcnyaTauii npucTpoto Ta 36epexiTs ii 4na noganbLio-

ro BUKOPUCTaHHA B AKOCTI JOBiAKOBOro maTepiany. A6o AK aHTicTpec 3im’'ATanTe ii un pBiTb, Le
He [LOMOMOXe Y BUPILLEeHHI TEXHIYHUX NUTaHb, afie TPOXK 3aCNoKOIThb. loTpuMynTeca HaBefe-

HMX HVXKYe BKa3iBOK Mifi YaC BCTAHOBJIEHHA, eKCrlyaTauil, YNLWeHHA 1 TeXHIYHOro o6cnyroBy-

BaHHA NPUCTPOIO, W06 YHUKHYTU HeGe3neyHnX CUTyaLill, @ TaKOXX MOAOBXUTU TEPMiH Cy»K6um
npUCTpolo.

10.

11.

BrikopurcTOBYITE TiNIbKM OPUriHaNbHi 3anyYacTUHK 1 akcecyapy, PeKOMeH0BaHi BUPOGHMKOM.
LLlo6 yHMKHY TV NOLKOLXEHHA NPUCTPOLO, BiAK0UaiTe NOro Bif enekTpomepexi nif yac
rpo3u abo AKLLO BiH He BUKOPUCTOBYBaTUMETbCA MPOTATOM TPMBANOro yacy. Bukopu-
CTOBYITE TiNIbKN peKOMEHA0BAHWI BUPOOGHUKOM Kabenb X1BNeHHs, Wwob 3abesneuntu
6e3neKy Ta eNeKTPOMArHiTHY CyMiCHICTb. KO NpUCTpPii NOTPiGHO NigKNUNTL [0
BijeomarHiTopoHa abo Komn'ioTepa, BifKNIOUiTb MOro Bif enekTpomepexi, Wob YHUKHYTU

ypaXeHHA eNekKTPUYHUM CTPYMOM.

YHVKaliTe NOWKOAXKEHb Kabesio XKMBeHHA.

He nepeBaHTa)xyinTe po3eTKy, W06 YHUKHYTY NoXeXi abo
YypaXKeHHA eNIeKTPUYHUM CTPYMOM.

He BcTaBnAnTe CTOPOHHI NpeamMeTn y BEHTUNALINHI OTBOPHK
npucTpoto. Yepes BUCOKMI TUCK Lie MOXKe Npr3BecTn Jo
yparKeHHA eNneKTPUYHUM CTPYMOM abo KOPOTKOrO 3aMmKaH-
HA. YHVKaTe NoTpanisHHA BOAU abo ByAb-AKMX iHWWX PignH
BCepeanHy NPUCTPOIO.

He Hamarariteca peMOHTYBaTU NPUCTPIA CaMOCTINHO. 3Bep-
HITbCA A4NA UbOro B aBTOPU30BAHWUI CEPBICHUI LeHTP.
BigkntouiTb NpucTpin Big enekTpomepexKi Ta 3BepPHIiTbCA B
ABTOPU30BaHUN CEPBICHNN LLEHTP, AKLYO:

a) NOLLIKOMMXEHO Kabesb K1BJeHHA abo BUIIKY;

6) y npucTpiit noTpanuna Bofa abo CTOPOHHI npegmeT;

B) NPUCTPIl yrnaB abo NOLWKOAXXeHO NOro Kopmnyc;

r) NPUCTPIN He NpaLOE HAaNEXHUM YNHOM.

[nAa 3amiHn getanei BUpoOy BUKOPUCTOBYNTE OPUTiHaNbHI
AeTani 3 aHaNorivYHMMK XapakTepuUCTMKaMm, peKomeHa0BaHi
BUPOGHUKOM. BUKOPUCTAHHA HEOPUTiHANBbHWX eTanel Moxe
NPW3BECTN [0 NOXEXi, ypaKeHHA eNeKTPUYHMUM CTPYMOM
Towo. <
Mig Yac BCTaHOBJIEHHA NPUCTPOLO, 30KPEMa HAaCTIHHOTO MOH- < '
Taxy, JOTPUMYNTECA HaJaHNX BUPOOHUKOM IHCTPYKLUIN, Wwob
YHVUKHYTW Hebe3neuyHnxX CUTyauil i HelacHX BUNaaKis.
BcTaHoBRIONTE NPUCTPIN NULe Ha CTiNKY, WTaTMB, TpMMay abo
CTiN, WO BXOAATb 1O KOMMIEKTY abo peKoMeHA0BaHi BUP0o6-
HUKOM. He BCTaHOB/IONTE NPUCTPIl Ha HECTINKNX MOBEPXHAX,
o6 YHUKHY TN TPaBMYBaHHA N0l i NOWKOOXEHHA Npu-
CTPOI0 BHACNIZOK NOro nagiHHA.

He BnKOpMCTOBYNTE NPUCTPIN NOPAS i3 AXKepenamn Boau.
Hanpuknag, 6ina BaHHW, yM1BaNbHWKa, KyXOHHOI pakoBUHMU,
6aceliHy ToLlO.

_?-I'-‘:\
i ﬂ || -
\‘\'.'v\'- ke
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12.

13.

14.

15.
16.

Mepep ynweHHAM NPUCTPOIO BIAKIIOYITL NOrO Bif eNeKTpoMepeXi, BANHABLUN BUKY 3
po3eTKW. InA unieHHA NPUCTPOI0 BUKOPUCTOBYIMTE CyXy TKaHWHY. He BUKopucTOBYyTE
piaki MniiHi 3acobu abo aepo3soni.

He 6nokyiiTe BeHTUNALUINHI OTBOPU NPUCTPOID. HefocTaTHA BEHTUNALIA MOXe Npu3Be-
CTV [0 neperpiBaHHA NPUCTPOIO Ta CKOPOUEHHA TepPMiHY Moro cny»6u. He posmiwynte
NPUCTPIN Ha NiXKKY, ANBaHI, KUNMMi abo iHWKNX NOAIGHMX NoBepxHsAX. Llei npucTpiit He
npusHaveHnin Ana B6ynoByBaHHA B Me6i.

He BcTaHOBNOINTE NPUCTPI NOpAA i3 AXKepenamu Tenna, AK-oT obirpiadyamm, JyXoBUMM
wadamm abo iHWKM HarpiBasbHUM 06agHaHHAM.

PK-ekpaH BUroToBNIEHO 3i CKNa, TOMy 6yfibTe 06epexHi, Wob He MOLWKOAUTY eKpaH.
IHoAi geAKi HeaKTMBHI Nikceni MOXyTb Bijo6paxkaTnca CUHBOL, 3eN1eHO abo YepPBOHOIO
HepPYyXOMOIO KParnKot Ha eKpaHi, ane e He BNMBAE Ha NOro NPoAyKTUBHICTb.

YBara! MigknioyanTte NnpucTpin nuuie fo poseTKM i3 3a3eMNIeHHAM.
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1. Onuc npucrpoto

1.1 Oco6amnBoCTi NpucTpolo

> YnbTpaToOHKa pamMKa: pexum BifeoCTiHn

» Bucoka po3sginbHa 34aTHICTb: BinbHe MacliTabyBaHHA eKpaHa.
> YnbTpawnpoKnin KyT ornagy: fianasoH ornagy go 178°.

1.2 QyHKUii npucTpoto

> MipgTpumka exoay 4K.

> MiaTpumka ¢yHKuii DP Loop (Display Port Loop).
> lMigTpumka nosopoTy Ha 90, 180 i 270 rpaaycis.

> [ligTpMKa MaWwWnHHOIo KoAy.

> (DyHKLliﬂ aBTOMaTUYHOIO BUABNEHHA CUTHanNy.

1.3 Cneyndikauyii

[iaroHanb (gronmn): 55

Tvin naHeni: ADS

PosginbHa 3paTHicTb: 1920 x 1080 (Full HD)
AckpaBicTb (Ka/m?): 500

KoHTpacT: 1200:1

Kyt ornagy (B/T): 178°

LWBmnakicTb peakuii (CAC, mc): 8

ToBLWMHA paMK (KapTUHKA [0 KapTUHKN, MM): 3.5

MopTn BBOAY:

VGA, DVI-D, HDMI x2, DisplayPort, RJ45 (RS232)

MopTn BUBeAeHHs:

DisplayPort, RJ45 (RS232)

Fa6aputn (BXLUXT, Mm): 1214x684x94
Maca (kr): 28
CymicHicTb i3 KpinneHHAMN VESA: 400x400
MoTy»HicTb (BT): 171
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1.4 NigKnioyeHHA cucrtemm

RE232

RS232

Signal Input

Video Matrix
Video Signal
CTpyKTypa cucremmn
RS232 T
oUT
AC AC
220 DID 220
|

f

signal input “‘1:’:’4

!

1

RGB Matrix

l

RGB Signal

—

RS232
ouT

DID
2

Pt

signal input ““li"’-‘

t

R5232 RS232
ouT ouT
AC AC
220 DID 220 DID
3 4
signal input #5232 ; ; RS232
9 put™s signal input ™0

PC

RS232

bnok-cxema (2 Ha 2)
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1.5 YcyHeHHA HecnpaBHOCTEN

Y pa3i BUHMKHEHHA HeCnpPaBHOCTI HEraMHo BiAKMIOYITb NPUCTPIN Bif enekTpomepexi. He
HamaramnTeca caMOCTiliHO PO3i6paTy NPUCTPIN ANA NPOBeAEeHHA PEMOHTY, iHaKLUe Lie MoXe
Npu3BeCTy A0 aHYNOBAaHHA rapaHTii. Hyuxue HaBegeHo Tabnuuto 3 iHdopmauieio wopo
YCYHEHHA feAKNX HecnpaBHOCTEN. AKLO CaMOCTINHO YCYHYTU HECMPaBHICTb He BAAETbCA,
3BEPHITbCA B aBTOPU30BAHUI CEPBICHUN LEHTP.

HecnpaBHicTb

Cnoco6u ycyHeHHs

Ouncnnei He BMUKAETbCA
(iHQVKATOP KMBNEHHSA He
CBITUTbCA)

1. MepeBipTe, UM He NOLIKOAMXKEHA JTHIA XKMNBNEHHSA.
2. MepeBipTe, 4M NigKNIOYEHO NPUCTPIN SO eNeKTPOMepPeXi.
3. MepeBipTe, YM He NOLLKOLAXKEHO BUMMKAY XKUBJIEHHS.

Yci BiffeocTiHOBI 6/10KM He
NPaUIOOTb HANEXHUM YMHOM

1.MNepeBipTe HanalwTyBaHHA MOPTY NPOrpamMHOro 3abesneyeHHa Ana
Bifl€OCTiHN.

2. epeBipTe, 4N HEMAE NOLIKOAKEHb Y MOCNIAOBHOMY KaHaJli, a TakKoX
3'eJHaHHA MiX NPUCTPOEM Ta iHTepericom MMK.

3. MNepeBipTe, 4 HeMae Npobnem i3 nocnigosHM noptom K.

4. TepeBipTe, UM NPaBUIbHO BCTAHOBIIEHO afipecy GOKy.

[esKi BigeocTiHOBI 610KN He
NpPauoTb HANEXHMM YMHOM

1. MepeBsipTe, UM NPaBUILHO BCTAHOB/IEHO agpecy NPUCTPOIo.
2. MepeBipTe, 4M MOXKHA OKPEMO KepyBaTh OfHUM G/IOKOM.

BipgcyTHin Bxin VGA/DVI
[ns oHOro abo Kinbkox
npuUCTpOIB

1. MepeBipTe 3'€AHAHHA MiX NNATOK MPUCTPOIO Ta AXKeperioM CUrHany.
2. 3miHiTb ninito VGA/DVI ana nepesipku.

3.TMepeBipTe, 4n NepeBeAeHO NPUCTPIN Y BXIAHNIA PEXIM.

4. MepeBipTe, U He BUXOAUTb BXIAHWI CUTHAN 3@ MeXi BXOZY NPUCTPOIO.
5. Ana Bxogy DVI nigtBepabTe 3axonnenHa DDC Ta Buxia.
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2. Intepdenci posmipu
2.1 Cneyndikauii iHtepdency

P & &= e &= @ @] ()

DViinput HDMIMHL ~ HOMI 4K DP Input VGAnput  DPoutput RS-232input RS-2320ut  AC INPUT
MopT Onuc
Bxig DVI Bxig iHTepdericy DVI, fo 1920x1080 60 Iy
HDMI MHL Bxig uudposoro curHany HDMI, go 1920x1080 60 Iy
HDMI 4K Bxig uudposoro curHany HDMI, go 3840x2160 60 Iy
Bxig Display Port (DP) Bxif undposoro curHany DP, ao 3840x2160 60 Ty
Bxin VGA Bxin aHanorosoro curHany VGA, o 1920x1080 60 Iy
Buixig Display Port (DP) MocninosHuin Buxia DP, oo 3840x2160 60 Iy
Bxin R.S-232 MocnipoBHMIA KOMaHAHWI BXiA ANA ANCTaHLINHOIO KepyBaHHA
(po3Him RJ45)
BMX]H.RS_BZ MocnipoBHMIA BUXIA ANA AUCTaHLINHOIO KepyBaHHA
(po3Him RJ45)
Bxif 3miHHOro cTpymy [Ixxepeno xunBneHHA
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2.2 BapiaHTu po3mipiB npuctpoto

Mogenb i3 giaroHannio 55 gonmie, 3,5 mm
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3. MporpamHe 3a6e3neyeHHA

3.1 Po6oue cepegoBuLle

» OC: Windows98/2000/NT/XP/WIN7/Vista

> MinimanbHa KoHoirypauia LM: gsoagepHuin, 2,0 My i Buwwe

> Nam’atb: 1 b

» Bigeokapta: VGA, Bifo6paxeHHA noHag 256 Konbopis

> KopcTkun guck: 10M

> MocnipoBHMI iHTepdelic 3B’A3KY: cTaHJapTHWI iHTepdelic 38'A3Ky RS232 abo cymicHa
Mozenb

3.2 3anycKk nporpamHoro sabesneyeHHsA

MepLu HiX 3anyckaTy NnporpamHe 3abe3neyeHHs, NepeKoHanTecs, Wo
» niHia RS232 komn'loTepa AnA NporpaMHOro 3abesneyeHHA NpaBUIbHO MNiAKIYEeHa A0
KOHTpoOnepa;

> BiANOBIAHI CUTHaNbHI NiHIT KOHTPOepa Ta NiHiA XKMBJIEHHA NiAKMIOYEHi NPaBUbHO.

MopAagok gin:

1.  YBIMKHITb KOHTpONep, NiCAA YOro 3acCBiTUTbCA iIHQMKATOP.
3eneHni - CTaH 3anycKy; MOMapaHyeBui - CTaH OYiKyBaHHA.

2. Po3nakywTe apxiB i3 nporpamHuM 3abe3neyeHHAM AnA BigeocTiHu. Kepytoue nporpamHe
3abe3nevyeHHA He NoTpebye BcTaHoBNeHHs. 3anycTiTb Lcdwall.Exe (Man. 1).

MpumiTKa: yci onepadii MatoTb 6yTW BifKpUTi B MOCNiAOBHOMY MOPTY.
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W LCD WALL = o X
Systern Setting  Lamguage Help

S QBN :-"m 2| G

Main Set Soresn OF  Sereen OFF  Fundtiog Set Soreen Addr Merge Valerge 'l’r.exe_ Eemote Lan reflesh Balling Text

TN set

[ Auts Open Eafrugh |

Ingut syures

Input seures [F =F =
Input Ha I* -| Eemasa i
P u I Matrix Enable Exeruts

Watriz Type
HOBGENEG_ MM

™ Mix Matwix

Open COM | 4 |

| |

Fover m | Foser off |

B ¥ oo resicr [ B soue tresee | B Coobinacion So1 |
i Belay: ez -] r |
3 r = 105 J - . =
vk r I [ LT | i
| m i - JENEE
{Cam Closed “20m1-12:27 143852 Operstor
Man. 1

MpumitKa: BMicT iHTepdelicy moxe BifpisHATMCA Bif HAaBEAEHOrO BULLE NPUKNAAY 3 iHLWOI0
BepCi€lo NporpamHoro 3abesneyeHHs.

Onuc dyHKuin iHTepdeincy (Man. 1):

> Po60ua 30Ha: KOXKEH eJIeMEHT CiTKW NpeACTaBIIA€E BiAMNOBIAHNI KOHTPOSIbOBaHNI €KpaH, BU
Mo>KeTe BMOpaTy BiiMOBIAHNI KOHTPObOBaHWI 610K, KNaLHyBLUM MO HbOMY Ta MepeTArHyBLUN.

> 30Ha PyHKLiN: MiCTUTb YaCTO BMKOPUCTOBYBaHi GyHKLiOHaNbHi KHOMKM.

> 30Ha 3arosioBKa: KOPMCTYBay MOXe 3MiHIOBaTU BiJoGpa)keHH:A 3arofioBKa BiAnoBiAHO A0
BIaCHUX NoTpeo.

> 30Ha CTaHy: Bifobpaka€e CTaH NopTy, @ TAKOXK MOTOUYHUI MiCLIeBUWIA Yac, AaTy TOLLO.

3.3 HanawTyBaHHA nporpamHoro 3abesneyeHHs

1. KnauHiTb no ¢pyHKUiOHanbHil cxemi «HanawTtyBaHHA nocnigosHoro nopty» (Man. 2).

2. HaTucHiTb kKHOMKY «Refresh» (OHOBUTN), W06 aBTOMaTUUHO NigknounTn COM, a noTim
HaTUCHITb «Open» (BigkpnTn), Wo6 BCTaHOBUTY 3'€AHAHHS.

CON zet

|come |
[ Auto Open FKefrash

Opern COW

Man. 2
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> Pagku B po3gini «MapameTpu gucnnes» BCTaHOBMIOTLCA BiAMNOBIAHO A0 GaKTUUHMX NoTpe6.

> Hanpuknag, 2x2 y XP.
> AKLwo 610K Mae po3mip 2x2, BiA€OCTIHOBUIA MacVB MOBMHEH OyTN BCTAHOBEHWI Ha 2X2 Ancnnel.

3.4 HanawtyBaHHA igeHTUiKaTopa NpUCTpOIo

Yce obnagHaHHA Mae ID Homep 1, KOpKUCTYBay NOBUHEH BCTaHOBUTKM ID Homep aucnnes
BiANOBiIAHO JO BNacHMX noTpe6.

1. KopwucTyBaui 3 npaBamn agMmiHicTpaTopa BBOAATb NapameTp «Agpeca gucnnes».

2. [InA KOXHOro MallMHHOIo KOAY Ancnien BeefiTb BiANOBIAHWI CePINHUA HOMED.

3. HatucHitb «Modify» (3miHuTK), W06 3aBepwnTn npouec 3miHn ID Homepa gucnnes.

. %g @! -f

ween OH Sereen OFF Functiog Set Sereen Adde Merge TnMer ge Fresrs

Mac Keyp
Parel Unit (D Change:

Display Mackey | Displey ParellD |

Matrix In: O

Man. 3

Mpumitkn:

> Mig yac 3miHy ID Homepy 3unTaiTe MaWMHHWIA KOA, AKWIA BifOOPaKaeTbCA Ha eKpaHi, i

3MiHiTb BignosigHum ID Homep gucnnes.
» KHonka «System Settings» (HanawTtyBaHHA cncTemmn) CTa€ akTMBHOI NMLLE NiCNA BBeAEH-

HA NaponA agMiHicTpaTopa.
> [Maponb agmiHicTpaTopa 3a 3amoBYyBaHHAM — 111111. B moxeTe 3MiHUTK oro.

3.5 Bubip BigeocTtiHoBuX 6n0KiB

Bu moxeTe B1UbpaTy oAnH abo Kifbka BiaeoCTiHOBMX ANUCNNEIB, @ TAKOXK BCTAHOBUTW BXigHWI
CYrHaN, KNnauHyBLWY NPaBoo KHOMKOW MuLi, abo HaTUcHYTK «Freeze» (3amopo3nTu), Wwob
3aMOpPO3UTUN MOTOYHE 306paxKeHHs, | HATUCHYTU KHOMKY Lie pa3, Wob cKacyBaTy 3aMOPOXY-

BaHHA.
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W LD WaLL - a

System Setting  Language  Help

Se SEEIN iz == 22 | O

Enin et Sereen OB Sereen OFF  Functing Sat Screen dddr Harge UrMargs Frenss Renots Lan raflash ﬁuuw; Toxt

g TN set-
HOWT s e =
| xl

Matrix In: 1
T Aste Dpen Refreah

Loput 1eeres
Toget vewres B0 =] f =
Tngut Bei |1 w] Baness

¥ Matrix Enable Exesute
Harriz Typs
MBS
[ Hin Watrix
Open o | Y I
Ponaran | Fover oft |
¥ ordar Bffect [ Matrin Ceafig | B0 Sceme Froset | I Combination Set |
Matrin Tope hddr Dalayi [I50ma = |
AV ﬂ ae | ™ fx: ] | =1

v il { z R
7 ,—j * iRAL i

3.6 06’egHaHHA

[inA KinbKoX BifeoCTiHOBMX AnCNNeiB, Hanpuknag, 2 Ha 2, nicna Bubopy ekpaHa 4 BnbepiTb
OKepesio CMrHany 3i CNucKy Axkepen CMrHany, a noTiM HaTUCHITb KHOMKY «Execute» (BukoHa-
Ti), Wob 3aBepwmnTy Npoueaypy. HatucHiTb kKHonky «Image Freezing» (3amopo3utu 306pa-
XeHHA), Wob 3aMOopPO3nNTN NOTOUHE 300pax)eHHsA, i HaTUCHITb KHOMKY Lie pas, Wwob ckacyBaTy
3aMOpPOXKYBaHHA.
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= 1D WaLL
System Setting Language Help

L& . bz -

Adwin Main Set Soreen OF  Soreen OFF  Functiog Set Soreen I\d.dr Nerge

=19

Freeze Fewate Lan raflesh H.qllm; Taut

0N set

__.:"
I™ hute Open Bafrosh
Lrput soures
Trput sourcs [0 2
Ingut Fo [ =] Bename
™ Matriz Bnable Exveste

Matrin Type

HOWGED BG_HIMI

[ Wix Matrix
Gpem 08 | Clesecm |
o | Fover off |

P Bocder 2ebace [ Watvin Confic | Scone Pronst | I Conbinaticn St |

Watris Type Al B o ] 5t

o FEENO O m| W ) |

- T o oo [cmesnx

g Tw | — | | emsss
Man. 5

Micna 06’egHaHHA MiX gucnneamu 6ynyTb WBK, HAaTUCHITb «Eliminate the border» (YcyHyTn
MeXi) i BCTaHOBITb BifMOBiAHI 3HaUeHHSA, W06 3p06UTN 306paxKeHHA CyLiNbHUM.

W LCD WALL - =} b4
System Setting Language  Help
lh
He § B s ms I - %
- -l |
Bdnin Enin Set Sormen OF  Screen OFF  Functiog Set Scresn nair Werge [ Frassn Fenote Lo reflesh Belling Test
O xet
[ #ute Opan Refrach
Rt 1

Ingut sowras

Ingut sourae E j j l
Trgut Na: N - j |
[~ Watrix Enahle Fxecute

atriz Trpe
OGRS M

I Mix Matrin

| |

P¥ Bardes 26ect | [ Matrin Confip | B Somne Prosst | B Cosbination Set |

P Bordar (na) sat
H 5 v F
Com Closed I J0a112-27 16aran Operator

Man. 6
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MpumiTKa: 3HayeHHA paMKn BCTAaHOBNIOETHCA BifMOBIAHO A0 i3MUYHOT pamMKKM eKpaHa.
Ha man. 7 nokasaHo epeKT BUAaneHHA pamKu.

OyHKLiA BUaneHHa pamkn He 3acTocoBaHa.  DyHKUiA BUAANEHHA PaMKM 3aCTOCOBaHa.

Man. 7

3.7 Bubip axepena curHany

BubepiTb fxKepeno curHany Ta HaTUCHITb KHOMKY «Execute» (BukoHaTn).

" LCDwall - o x
System Sefting  Language  Help

S BEEBN :="m = | O

himin Maiin Set Soween OF  Soveen OFF  Punctiog Set Sereen Addr Warge rler ge Fraeze Remate Lan reflesh Relling Temt

T vt
=l
™ Mats pan Bafrash

Ingrub oercs

Tagat swrn I =] [ =]
Tnpat Ho |- S Bates

MO 4K
[ Hatrix lnh{;p

Ratrin Tipa LoD

MI0_¥oA
T~ Min Matriz

e |

B ecdue éfect | Q) Mateis Conéiy| B Sevan 7razee | B Conbination Sot |

# Bordar i) Eat
TR

Man. 8
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3.8 BBimKHeHHA maTtpuui

1. HatucHitb «Matrix Enable» (YBiMKHY T MaTpuLio) | BUGEpiTb HOMEpP BXOZY MaTpuLi:

W (COwaALL - E
| gystam Setiing Laﬂgnage

| T
ar [+ e o B - ¥
o= PN | s )
l.m. Sat  Screen 0 Serewn OFF Functlog Sat Seran ld.df Marga e gu Fraate Beacts  Lon reflesh Bolling Tase
I Z O st
DKL [Fre -

1™ huke Opan Kefrash
Trgue oures

Zagus sawren (M2 =ik =
Izguz ¥a 1 =

™ Matriz Enab

r
L X Batriz Type
SHS_ ¥

I~ Nix Matrin

open com | o |

Four on | Fowar aff |

P bocder Bifeor B Matrix Confic | B Soenn traaat | B Cobination Sat |

Mg [ o e
LTI |

= i
o] T =zl e K L
= — @ fraaeits

Man. 9
2. BnbepiTb TN MaTpuLi Ta HanawTynTe ifeHTUdIKaTop MaTpuLi.

MpwumiTtKa: pi3HU B1GIp MaTpuLi Ma€ pi3Hy 3aTPrMKY yacy.

- LD wiALL - o X
Systom Setting  Language
& -E!.E!. L TP Y
= 4
| Main Sat Serasn O Serawn OFF Funotlog Set Soreen M Wargs Uil gu Fraage Bemots Lan reflesh Belling '[Ill
2 OO sat
EDKI
[ o
[~ te Open Kk b
Trput vourse
Tagit $iiren P2 =1pF =
| Ixguz ¥a 1 ] e |
| e
| o [~ Matrix Enable_Erssuts |
1 EDHI ) ="
| Matriz Type
SHS_ Y
I~ Mix Watris

open com | .|
(P HEMT | S e oy |

—— oo | |
¥ Darder urm Soesa Prazat | [ Coabisation Set |
! Ml [F =] o
Ay =l
| o =l - Pt
; W [ = il R CUN




3.9 NonepeaHe HanawTyBaHHA CLEHMN

> MigTprmye 16 BUAIB CLUEHN, IMEHA AKX MOXKHA 3MiHIOBaTHU.

> LLlo6 36eperTu cLeHy, HaTUCHITb «Save Scene» (36eperTu cueHy), i Moaenb 6yae 36epexxeHo
> LLlo6 3aBaHTaxMTK 36epexkeHy cLeHy, HaTUCHITb «Load Scene» (3aBaHTaXXUTU CLEHY).
> PeXXum onnTyBaHHA CLEH MOXKHa 3anyCcTUTY BignoBiAHO A0 NoTpeb KopucTyBaya

OEw == G

Main Wuin Sat  Seraen 0N Terawn OFF Fumetiop Set Seraan ddde

Frases Baibs  Lam reflash hllm: Tazt

i CIM st
% Scens Preset - o = B
1t Open _!.cf:ihj
Soene Select
Scene Select | saurce
pererog | el Tl Ty | s [ 1R ]
scereld | scereld
scenell soenelS i - .R'“'".]
Losdseene | Sav Some | eeely_rernl® s Taakly Braruts
(TR N Bl type
™ Stene Al Pefig Enabied |k
= Matrin
Save =77 i e
T

B Berder Bffert | B Matvin Config I Coshiration Sat |
[soxe Pramnd]

Man. 11
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3.10 HanawTyBaHHsA N3

1. HaTucHitb KHonky «Admin» (AamiHicTpaTop) i BBeAiTb naponb agmiHicTpatopa 111111y
CNANBAOYOMY [1iaflorOBOMY BiKHI.

-
mlem Seging Langusge Help
g il & bz - ¢
] a4 - ™ \Qi} X i
hdsin ks St Berwan 08 Serawn OFF Funotieg Sat Soreen hidr Marge !nu- Hamets Ean vaflesh Belling Taxe
u‘ 53] z CON pat
I B} ot HOAI T
Matriz In: 1 Batriy In: 1

I bty Gpan Rafrech

i Tmput womce
Admiristrator x
Tagns soeres O = =
Adninistrater parword (3] Login | Input Bo: |1 <] B |

| Q # Ratrix fndle Tzwcuts

Wntrin Type

i ,..—,a\ e | MIHIHG, IR
I Mix Matrie
Password: 111111 T
ke Mjurr. |

Fover on | Ponur aff |

BE berder Bifest B Mateis Conic |£l I | W Cotination S-tl

Batriz T Al Dwy: [ -] W
e T = ]

" — || emenik
= * Bt

Com Closed 2021-12-28 0%:08:14 Chperator

Man. 12

2. HatucHiTb KHonKy «Main Set» (OCHOBHI HanalTyBaHHA) i 3ajaniTe HaCTYMNHi NapameTpu y
CNANBaYOMy AialoroBOMy BiKHi.

W LoD WALL

o x|
System Setting inge  Help
Adnin Sermam I8 Servan OFF  Functiog Set Serem IH.r Marge Frasta Ranoks Laa ruﬂn.l Balling Text

2 8 sut

Bt 3

Matrix In: 1
[~ duste Opes Befresh |
Trqut wanres

Toput earce TRE s =
Ingut B i v] Rememe
JNI ;DII ¥ Matrin Esable Exesuts 1

i : 5 o Hatriz Type-
atriz In: 1 Matriz In: 1 I

™ Mix Marrin

[ ] |
At Rdjust

Fesran | Fovur off |

¥ torder 2htee [ Matrl Confic]| ] sane Peases | B Conbinabion Sat |
Wairly Typs Adde Dlay:  [ias =] Watrix Outgus Sas I'
W JEER = ok [ A Marie e com oy <]
Woa.  FUOVSL S8 OE | Vek Mateix Use cotot] ] B g
v [EESIEC ST o | [ I Matrix Use coM 0] =] 2 bt

Com Clased 2021-12-26 090512 - M’_}_ S T |
Man. 13
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SEOEN : ="m 2| ¢

Adnin Wiin et Serwsn OF  Seresn OFF Funebiog 54t Serawn ddde Baign Vel o Franea Bémsts  Lun uflesh Balllag Tawt
1 2 O sat
HIMT HOET e
Matrixz Inz 1 =
Adjwst Objast I~ huta Dpem Bafeash |
™ ¥idew - Adjet Rangu 0, = 0.1
Picturs | Gucmntry | Color Teap | Systes| Fan | Panad | Input soures

T L] N |
L S T
e 7 Mutriz faably_tsoute |
Shurpuers = |+ |

A I Lot |

I~ Min Matrix

sy | i
bt djust |

1=y o — Fover an | Fover oif | |

BY Border Effect (B Mubris Confic ] Soene Froset | I Cosbination St |

Watris Type  hddr e Matrix Output Sar |
PSR = R 2 TR R ) IO [ ——
vk [BELOWE = J0 OB | T ¥GA Matris Uee COR w =) L | © EETiiE
wy  [OPRDR A 8 0K | [ OVD Batriz Use 0Dl ) il b L]

Com Clased | 20011228 D106 Adeninistrator
Man. 14

MpumiTka: focTyn Ao HanawTyBaHb Ma€ Nnwwe agMiHicTpaTop.
Y ubomy MeHio aBa napametpu «Video» Ta «VGA» BU3HAYalOTbCA Pi3HUMU AXKepenamu cur-
Hany; KOXHe 3 HanawTyBaHb y BileoCTiHOBOMY 650U Bifo6pa)kaTumeTbCsa BiANoBigHo.

3.10.1 HanawTtyBaHHA 306paKeHHA

Akwo y 6noui «Adjust Object» (HanawTyBaTtn 06'eKT) BUbpaTn napametp «Video», MoxKHa
HanawTyBaTu napameTpu «Brightness» (AckpagicTb), «Contrast» (KoHTpacT), «Color» (Konip),
«Sharpness» (Pi3kicTb), «Tint» (BiaTiHOK) i «Color Restore» (BigHOBNeHHA Konbopy).

AKkwo y 6noui «Adjust Object» (HanawTyBaTn 06'eKT) BU6paTn napameTp «VGA», MOXKHa
HanawTyBaTu napameTpu «Brightness» (AckpasicTtb), «Contrast» (KoHTpacT) i «Color Restore»
(BigHOBRNEHHA Konbopy).

Settiing X fellivyg b
hdjust Object wie T
@ Video " VGA Adjust Ranze 0,1 - 0,1 LA (o | | LI T TR
(BLEBis ) Geometry | Color Tenp. | Systen | Fan | Panel | LI TTIN - IR e R I O LT |

Erig}\tnessj _*I tr:ﬂ.frd::J J
Contrast J _*I I gt J J
Color J _~| —aler J J
S}\arpness;l _+| shurpraa J J
Tint J _‘I Colox Restore ez J J P FLEE N

Exit ik

Man. 15
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3.10.2 HanawTtyBaHHA reomeTpii

Akwo y 6noui «Adjust Object» (HanawTyBatn 06’eKT) BUbpaTn napametp «Video», MoXKHa Ha-
nawTyBaTtu napameTpu «HPosition» (lopn3oHTanbHe nonoxeHHsn), «Hsize» (fopr3oHTanbHMN
po3mip), «VPosition» (BepTrKanbHe NonoxeHHA) i «Vsize» (BepTukanbHUI po3mip).

Akwo y 6noui «Adjust Object» (HanawTyBatn 06'ekT) BUb6paTn napametp «VGA», MOXHa Ha-
nawTysaTtu napameTtpu «HPosition» (fopnsoHTanbHe nonoxeHHs), «VPosition» (BeptukanbHe
nonoxeHHs), «Clock» (YacToTa) i «Phase» (Da3za).

—  |swning % |
:@5&”"1 A RAJRIT RLM ol = o f't-"'i‘::’;m = Ex Adzuck Sage 1 =01
Foizera LAsTATrY |_¢'_¢.- aamp |z [ re [Pl | Zickow VesmeRt Uil Twg | ook | Do ETA
e o - M. rijeas “ = | J AN aduck
biiza 1 - L8 WY = = J | Amald. = | + |
shaszen | ek - - iveibina J + | Al - | + |
=, ] [T o J J SvAL. - | + |
an ]
H|E e )]
S L]
Man. 16
MpumiTka: HanawTyBaHHA ADC HepgocTynHe.
3.10.3 TemnepaTtypa Konbopy
Ona napametpis «Video» Ta «VGA» MoXKHa B1bpaTy 6anaHc 6inoro.
tistting 7 V 5 :"'"i"E &
adzark sk "f-i'“': -k _ ..
i F e Adeart Segeu 1 - w1 naiae [ [T AT A U
Zickow| dumabn Velw Tug |socka | fa | Sael | Pranera | Lasmazey gl AR |'-5"'-" [ b [hena |
CIE CRTTT) LI T FTTR
el JJ R - e i Lo | B AF:
a AT Ll (e L
"'""JJ AT e \ 000 P | rae ||
we ] o LI
I |
L5 e
Man. 17

3.10.4 HanawTyBaHHA cucrtemMu

Y meHto «System» (CucTema) MOXKHa HanawTyBaTh ACKPaBiCTb NiACBIYYBAHHA, PEXMM CUHBOIO
Ta YOPHOTrO eKpaHa, OHOBJIEHHA MPOrPamMHOro 3abesneyeHHs, aBTOMaTUYHE HaNalUTyBaHHA
no3uuii VGA Ta Konbopy ToLyo.
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Man. 18

v

Backlight: BukopucToByeTbCa na peryntoBaHHA ACKPaBOCTI NigCBiYyBaHHA.

» Auto ADC: AKLLO 3Ha4YeHHA, oTprMaHe B pexunmi VGA, € HenpasuibHUM, i Konip Bigobpa-
YKAETbCA HENMPABUIIbBHO, HATUCHITD LiI0 KHOMKY, Wo6 cnpobyBaTty e pas.

> Blue Screen On: npu HaTUCKaHHI Lli€T KHOMKM BMUKAETbCA PEXUM CUHBbOTO eKpaHa, i Konu
HeMae CUrHany, eKpaH CTa€ CUHIM.

> Black Screen On: npu HaTWCKaHHi L€l KHOMKM BMUKAETbCA PEXKMUM YOPHOTO eKpaHa, i Konm

HeMag€ CUrHasy, eKpaH CTa€ YOPHUM.

Factory Reset: HaTUCHITb 10 KHOMKY, W06 BiJHOBUTM 3aBOACHKI HanalITyBaHHS.

v

3.10.5 Apgpeca eKkpaHa
Syster Seming  Langusge  He
N
o OIS : =" 2] 4
&b a4 = -.l
Rinin Main Sxt  Srrean 0N Sewsen OFF Fumctiogp Soff Screan Addr Barge ellar g Froacs Eemaote  Lam reflach Belling Text
! O aat
FDNT e
Matriz In: 1 [ =
S parel 1D cet [ dute Open Eafrash |
Inpet searen
i Togat seirce (O =P =
PawlUm | U‘ﬂf| i e
:‘;.11 Dueplay Wik | Disglay FanellDl_ | ¥ Batrin hubl-_’-*f“‘:_‘:J
Matrixz In: 1 ::-:n;”m‘m
[ Mix Metrix

Open OO Close o |
Auts hdjunt - I
el

| Fovur aff |

Man. 19

HaTuncHitb «Screen Add» (Agpeca eKkpaHa), 3'ABUTbCA CAMBatoYe BIKHO, AK MOKa3aHo Ha Man. 19.

Man. 20
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Yci BigeocTiHOBI NaHeni matoTb 3aBOACbKY agpecy 01 01, KopncTyBay MOXe BCTaHOBUTY agpe-
Cy BifNoBigHO A0 BRacHMx notpeo6.

Cnoci6 HanalwTyBaHHA:

1. Bipo6pa3siTb MalWMHHWI KOA €KpaHa BHU3Y eKpaHa, Ak MoKa3aHo Ha mar. 20.

2. HatucHiTb «Screen Add» (Agpeca ekpaHa), 3'ABUTbCA CNIMBaloYe BiKHO.

3. BcTaHOBITb agpecy ekpaHa i HaTucHiTb «Modify» (3MiHUTK), W06 3aBepLUINTY 3MiHY
agpecu.

3.10.6 OHoBneHHA N3

1. Ckonitonte MERGE.bin y kopeHeBuin katanor USB-HakonmnuyBaua, He 3MiHiooum iM'a Gaiiny.

2. Bcraste USB-guck y USB-nopt gucnnes.

3. HatucHitb KHOMKY «Software Update» (OHOBUTU nporpamMHe 3abe3neyeHHs), AK MoKa3aHo
Ha Man. 21, eKpaH CTaHe CUHIM, MPOrpec OHOBJIEHHA NPOrPaMHOro 3abe3neyeHHs Bifobpa-
KaTVMETbCA Y BEPXHbOMY MPaBOMY KyTi, @ iHAMKATOP XMBJIEHHA MOYEpProBo 6nnumaTume
3e/IeHUM | MToMapaHyYeBUM, MiCNA YOro OHOBJIEHHA byfle 3aCTOCOBAHO aBTOMATMUYHO.

W

CEN == 2 | Gag

hdbin Muin 4t | Sorees OF  Screan OFF Punetiog Set Stree Adir Mur g nltar go Fraaze Beacts  Len refled Balling Test
T et
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¥ seiing " =]
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Man. 21

MpumiTka: He BUMMKaliTe XKUBNEHHA Ta He Bia'eaHyTe USB-AMCK Nif Yac OHOBMEHHSA, iHaK-
e e MoKe NPU3BeCcTN L0 NOWKOAXKEHHA MPUCTPOLO.

3.10.7 HanawtyBaHHA BeHTUAATOPA

Lia dyHKUia HepocTynHa y AaHin mogeni.
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3.10.8 HanawTtyBaHHA naHeni

OwnB. man. 22.
-

DR :—=m | O

Adim Hain 3ot Sorwer N Scrwen OFF Fasatiog Ser Seraen hddr Bargs Frasae ot Lum reflesh 'hllml Taxt

O e
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[T huts Opas Bafrash

Settfing b

Mjust 0bjest

& Wides W Adjust Bange 0.0 = 0,0
Fioture | Geosatry | Calor Teep | Syatem | Fan Tagut saurce
Tngut vaurce |1 ]‘ B ]‘
Swagart Swaplh EwapFol Tilads TiBi thods -
i - & o P Tsgut Ba: 1 - hwnl

S ™ Max Matris
Opan [N Cloze 0o
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erlt In: 1 3 Hatriz Type
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Batriz Type  addr Dalig:  [i50e: =]

[ . ©EEiks
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3.11 HanawTyBaHHA PYHKLiN

1. HatucHitb KHonkKy «Admin» (AgmiHicTpaTtop) i BBefiTh Nnaponb agmiHictpatopa 111111y
CMNBAOYOMy AiaNioroBOMYy BiKHi.
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cogtem Seging language  Help

L I T

hidsin Mais St Serwan O Serawn OFF Funotleg Sat Soreen hidr Marga Fravea Humetu Lan vaflesh Bolling Taxk

; = 7 CO 5t
HOAT £ HOAI '—_|
Matrix In: 1 Ratriz In: 1 s
I hets Ogan Rafresh
s Taput semar
Admiristrator b
Tagnt sores (O Ak =
Adninistrater parmerd (3 Legin | e N I <] R |
l [ Matrix fnale Emeubs
Batrin Type

Changs parmard Class KOG I
I~ Rix Matris
Password: 111111 i o
ke Mjunr. |

—— . Pover on | Powar o |
! ey [ %
e ! ; ; C R
i =7 I . . " HHERS IS

Com Clased 2021-12-28 000814 Chperator

Man. 23

2. HatucHiTtb KHonky «Function Set» (HanawTyBaHHA GyHKLUIN) | 3aaaiTe HaCcTyNHi NnapameTpu
y CNANBAOYOMy AiasioroBOMY BiKHi:

-
- & Funcsicg Set - o x
IPAD Y | Sermen Saver Piowas ors LOGO Pctus Flotate #
| ~ A =
Nm Swun o Scrun 2 Fof Con | |Fon Fon | Fa m ag Tamt
] Fim
1 Teguiles Merge Licence 'Wamng:
IPRINEY | COf COn || Cof ¢ On ~m ™ UPD_MiR
JPHONEH T Display P Ellact i
B | o o ©0n  Hadt Mol
= =
Mo ok smmiad e Set
semal ! sestul s chargng 1ate Update Tims  cisanad
Tanar
Tmar
Mode an =] Posso [0 =] How [0 =] M

M [T 3] Poen [ ] e [0 3] e
a0 S
i

HOMUDN Sigral Strengthen HOMIAWA Etmndt W Serial port
. erial port
o = —— = | il | b | e | o | ¢ Network port e |
T
s (Seversettings,  [gyiamd
. [EE P Adess S2166 16 254 Control mode
v [EEID
mr [ g VEP O DVDMasris Vew COMOnly D
Cam Closed 20211230 05:42:56 Adenivéstrator

Man. 24
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3.12 BcTaHOBNEHHA Ha3BM

HaTucHiTb «System Settings» (HanawTtyBaHHA cnctemu), a NoTiM y CnaMBaYoMy fianoroBomy
BiKHi HaTUCHITb «Title Set» (BctaHOBUTY Ha3By).

& LD el 2 =] =
System Setting  Language Help

Admin )
e |FAF W ke - K2
i J 34 -l
Thie Sai Sereen 00 Serven GFF Fmctiop St Seremn Adr Urltarge :..m Ruaate L rallesh Malling Toxk
Rl Polling = ——
Color Adjust HONI | 5
S Watriz In: 1 =
I dnte Dpes _Ralredd |
Ingat searer— = —
Tnpat seures [ B
Tnpet Yo 1 =] B |
B g ;-..- ¥ Matrle Bnably Eecute
hi. b3
3 < i T Yatrix Tipe
atrix In: 1 Matriy In: 1 ™
I iz Matris
Opan OO Cloza OO
huts hdjuze
Poar an | Bonar off |
B bordar zéfect | B Mutels Canfic]| ) Sema Frasee | M Conbination Sat |
Matrlx Typs Al Dabay.  [1%0ws ® Matriz Outpat Sat
w W -Jf I™ ¥ Batrin Use COM Dnly
v o =IF 0K | 1 e Marein Ve OO m]—_| | o bianin;
oy (SRS EESIR 0K | [ VD Mawis Vs COOSY B L
Com Cloted 20271-12-29 10:46:38 Administratos
Man. 25
8 Tide Set - o ®
Title
JLEDwsLL Change
Uses Name
||l e Compary Hame
Compary ‘Webaite
| Chiange
Uses Logo

o

_ |

I

Man. 26

> Title: koprcTyBau Moxe 3MiHWTU Ha3BY BiANOBIAHO [0 BNacHMX notped.

> User name: KOprCTyBay MOXe 3MiHUTU iM’'A KOpUCTyBaya BiAMOBIAHO A0 BlacHMX noTpe6.
» Company URL: kopuctysau moxe 3miHuTn URL-agpecy BianoBiaHO f0 BnacHMX noTped.
User LOGO: KopucTyBay MOXKe 3MiHUTY TOroTWN BiAMNOBIAHO A0 BNACHMX NoTpeo.

v
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MpumitKa: BigKkpuiiTe Kepytoue nporpamHe 3abesneyeHHs, KNauHiTb y HUXHbOMY NiBOMY
KyTi o6nacti JJIOTOTUMA. HatucHitb «Open» (BigKpuTn), o6 NifKNIounMTMCA O BCTaHOBNEHOT
URL-apgpecn.

3.13 Bubip moBm

KopucTyBau moxe BUGpaT MoBy.

100 WALL - o X |

System Sefting  Language Help

Jo C I Pl I e

Main Set Ferasn ml Farees OFF  Functiog Set Soren Mddr l"u Frﬂl( Fesate Lan reflesh Folling Tent |

 m——

I hato Open I-{-u‘hJ

Inpet reurow

Input zewrce .ﬁ :" 5 :“
Input He f =] Enmme
¥ Watrin Endile Toncsts |
Harrix Tope
HORGEIING KR
s kel
Open. OO |
ST T |
Poer e | e ot | |
B% Border Bifens [[B) Habriz Canfip | ) Soene Frosar | I Cosbination ez |
Warrin Tope bédr L o (AP | [
W SN - = : |
b = r ik,
= — & RS
wr |
Com Closad 2021-12-29 15:4642 Operator
Man. 27

4. MocnipoBHicTb NigKNoYeHHs iHTep¢eicy RJ45

TX,RX,GND-2,3,5
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5. MynbT ANCTaHUINHOro KepyBaHHA

5.1 MynbT ANCTaHLINHOro KepyBaHHA

Man. 29

5.2 IY-npunmau

IY-npuitmay noTpibHO NigknounMTK A0 eKpaHa 1 nocnifgoBHOro naHutora yepes nopt RJ45 IN.

5.3 HanawTtyBaHHA agpecn eKpaHa

1. HatucHitb kHonky «MENU» (MEHIO) Ha nynbTi ANCTaHUINHOIO KepyBaHHs, 3'ABUTbCA TaKe BiKHO:

Input HDMI2
Brightness 100
Contrast 100
Backight 100
Saturation 98
Sharpness 2
Volume 50

4 9 < D>

Man. 30

HatuchiTb «Input» (Bxip). Hanprknag, AKLIO BUKOPUCTOBYETLCA Axepesnio curHana «HDMI2»,
B1bepiTb «HDMI2» 3a fonomoroio KHomnok «JliBopyu» i «[paBopyy», NOTiM HATUCHITb «MENU»
(MEHIO), wob6 36eperti 3miHu.
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2. Mepenpitb Ha cTopiHKy «MachineCode» 3a fonomorot KHonok «JliBopyu» i «[paBopyu»
B €KPaHHOMY MEeHI0.

Machine Code 26047
Ten Thousands 2
Thousands 6
Hundred 0
Ten 4

4 9 < D

Man. 31

BcraHoBiTb «Ten Thousands», «<Thousands», <Hundreds», <Tens», «<Ones», MOTiM HAaTUCHITb
«MENU» (MEHIO), wo6 36eperTtu 3miHu.

3. MepenpiTb Ha cTopiHKy «Video wall matrix setting» 3a gonomoroto KHonok «JliBopyu»
i «[paBopyY» B eKpaHHOMY MeHIO.

Unit ID 1
Merge Mode

Start Row 1
Star Col 1
Start Row 2
Star Col 2
Counter Row 2
Counter Col 2

4 9 < >

Man. 32

AKLLO BM XOUeTe HanaluTyBaTh MaTpu1Lio 2X2, BCTAHOBITL «Start Row» (MouyaTkoBWiA pAdoK) Ha «1»,
«Start Col» (MouaTkoBuMI cToBMELb) Ha «1», <kEnd Row» (KiHueBuin pagok) Ha «2», <kEnd Col» (KiH-
LieBUiA cToBMeLb) Ha «2», «Counter Row» (3ycTpiuHnii pagok) Ha «2», «Counter Col» (3ycTpiunnin
cTOBMeLb) Ha «2». «|geHTUdiKaTop NPUCTPOIO» — Lie MOTOYHMIA HOMEepP PO3TaLlyBaHHA MaTpuLi
eKpaHa. BctaHoBITb BifnoBigHWI ineHT1dIKaTop, NOTiM BCTAHOBITL ANA pexKnMy 06'€eAHaHHA 3Ha-
yeHHA «Merge», a noTiM HaTUCHITb «MENU» (MEHIO), o6 36eperti 3miHW. AKLLO BM XoueTe BUATU
3 PEXMMY MaTpULi BCTAHOBITb AN1A peXxnmMy 06’€HaHHsA 3HaueHHs «Normal».
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Bupo6Huk: Manig Nimitea. Anpeca BupobHuka: odic/kab. 9, 25/® Konkoppia Mnasa, 1 CaitHc
Mysiym Poya, Tcimwatcyi, KoynyH, ToHr KoHr.

ImMnopTep B YkpaiHi: [N «J10TH». Agpeca imnopTtepa: Byn. Mapka Bosuka, 6ya. 18A, m. Kuis,
04073.

Martepian: nnactuk, metan. Bignosiga€e Bumoram fito4oro caHiTapHOro 3aKkoHoAaBCTBa YKpaiHu.
He noTpebye cneuianbHUX ymoB 36epiraHHs.

[apaHTinHUM TepMmiH: 36 micALiB.

CTpok cny»6u: 5 poKiB 3 AaT Npoaaxy.

BurotosneHo B Kurtai.
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Mepbl NpeaoCTOPOKHOCTIN

BHMMaTeNbHO NPOYTUTE AaHHYIO MHCTPYKLMIO MO 3KCMyaTaLuy yCTPONCTBa M COXpaHUTe ee
ANA fanbHenwero NCnonb3oBaHNA B KauecTBe CNpaBoOYHOro matepuana. Cnepyiite npreefeH-
HbIM HUXKe YKa3aHVAM BO BPEMA YCTaHOBKM, SKCTyaTaLum, YACTKN U TEXHUYECKOTO 06Cny-
XKMBAHUA YCTPONCTBA, UTOObI M36eXaTb OMAaCHbIX CUTYaLMiA, @ TakKe NPOAJINTb CPOK CIyXObl
yCTPOWCTBa.

10.

11.

Vcnonb3yiiTe TONbKO OPUIrMHANbHbIE 3aM4acTU 1 akceccyapbl, PeKOMeHAOBaHHbIE N3roTO-
BUTENEM.

Bo n3bexaHue noBpexaeHnA yCTPONCTBa OTKIOYalTe ero oT 3/1eKTPOCeTU BO BPeMSA Fpo-
3bl UJIN €CNIY OHO He BYAET NCMoNb30BaThCA B TeUEHUE ANIMTENIbHOIO BpeMeHU. Micnonb-
3yWiTe TONIbKO PEKOMEHA0BaHHbIN M3roToBUTENEM Kabenb NuTaHus, 4Tobbl obecneynTb
6e30MacHyto paboTy 1 SNEKTPOMArHUTHY COBMeCTUMOCTb. Ecnin ycTpoiicTtBo Heobxoau-
MO NOAKIIOUNTb K BUAEOMArHUTOHOHY AN KOMMbIOTEPY, OTKIIOUMTE ero OT 311eKTPoCceTH,
4TO6bI N36eXKaTb MOPaXKEHNA SNEKTPUUYECKMM TOKOM.

M36eraiiTe noBpexaeHUii Kabensa nUTaHus.

He neperpy:kaiite po3eTKy BO U3bexxaHue noxapa unv nopaxe-
HVA SNEKTPUYECKVIM TOKOM.

He BcTaBnANTe NOCTOPOHHVE NPeAMETbl B BEHTUNIALMOHHbIE
OTBEPCTNA YCTPONCTBA. /13-3a BbICOKOTrO AaBfieHNA 3TO MOXKeT
NPVBECTY K NMOPaXXeHMI0 3N1eKTPUYECKM TOKOM UJIN KOPOT-
KOMy 3amblKaHmio. /136eraiite nonagaHnsa BOAbl UK APYrrX
XnakocTen BHYTPb YCTPONCTBA.

He nbiTanTecb peMOHTMPOBaTb YCTPONCTBO CAaMOCTOATENIbHO.
O6paTnTeCh AN1A 3TOTO B aBTOPU30BAHHbIN CEPBUCHbIN LIEHTP.
OTKoYMTE YCTPOMCTBO OT N1EKTPOCETH 1 06paTUTECh B aBTO-
pV30BaHHbIN CEPBUCHDBIN LIEHTP, €CN:

a) MOBPEeXAeH Kabenb NUTaHWA NNV BUNKA;

6) B yCTPOWCTBO nomnana Bofa Uiv NoCTOPOHHUI MPeaMeT;

B) YCTPOWCTBO YNasno Uau NOBpeXAeH ero Kopnyc;

r) yCTPOWCTBO He paboTaeT JONKHbIM 06pa3om.

[lna 3ameHbl feTanen nsaenna NCNonb3ynte opurnHabHble
fleTanu C aHanornyYHbIMU XapaKTepuUCTUKamu, peKoMeHA0BaH-
Hble N3roToBUTENEM.

Micnonb3oBaHMe HeOpUrHaNbHbIX AeTane MOXeT NPUBECTU K
noXapy, NOPaXXeHUIo 3N1eKTPUYECKUM TOKOM U T. A. -~
Mpw ycTaHOBKE YCTPONCTBA, B YaCTHOCTM NPY HACTEHHOM MOH- < '
Take, cneflyiTe NHCTPYKLMAM N3roToBUTENA, YTOObI M36exaTb
OnacHbIX CUTYyaLWiA K HECYACTHbBIX CITyYaes.

YcTaHaBnuBamTe yCTPOMCTBO TONbKO Ha CTONKY, WTATWB, Aep-
XaTtenb UNn CTOJ, BXOAALLME B KOMMEKT UM PEKOMEHA0BaH-
Hble U3roToBUTENIEM.

He ycTaHaBnuBamTe yCTPOMCTBO Ha HEYCTOMUYUBbIX MOBEPXHO-
CTAX BO M3b6exaHve TPaBMMPOBAHUA Ntofeli 1 MOBPeXAeHUA
YCTPONCTBaB pe3ysibTaTe ero nafgeHus.

He ncnonb3yinte ycTponcTBo PAAOM C UCTOYHUKAMM BOAbI.
Hanpumep, Bo3ne BaHHbI, yMblBaNlbHNKa, KYXOHHOW PakoBUHbI,

_?-I'-‘:\
i ﬂ || -
\‘\'.'v\'- ke
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12.

13.

14.

15.

16.

bacceMHa nT. 4.

Mepen unCTKOM yCTPOMCTBA OTK/IOUUTE €r0 OT MIEKTPOCETH, BbIHYB BUKY U3 PO3ETKMN.
[na yncTkn yCTpomncTBa NCNONb3ynTe CYXYI0 TKaHb. He ncnonb3yinre Xngkue morLmne
CpepcTBa Uav a3po3osun.

He 6n10oKnpyiiTe BEeHTUNALMOHHbIE OTBEPCTUA YCTpOCcTBa. HegocTaTouHaa BeHTUNALNMA
MO>KeT NPMBECTU K NeperpeBy yCTPONCTBA U COKPALLEHMIO CPOKa ero ciyx6bl. He pas-
MelLlaliTe yCTPOWNCTBO Ha KPOBaTU, iVBaHe, KOBPEe N APYrnX NoJoOHbIX MOBEPXHOCTAX.
[laHHOe yCTPOICTBO HE NMpefHa3HauYeHo Ans BCTpanBaHua B Mebernb.

He ycTaHaBnvBanTe ycTponCcTBO pAAoOM C UICTOYHMKaMU TEMJa, Hanpumep, oborpesaTens-
MU, BYXOBbIMU WKadaMm Un ApyrM HarpeBaTesibHbIM 000PyAOBaHNEM.

KK-3KpaH 13roToBfieH 13 cTeKkna, No3ToMy 6yabTe OCTOPOXHbI, UTOObI He NOBPenTb
3KpaH.

NHorpa HekoTopble HeaKTUBHbIE MMKCENM MOTYT OTOOpaXkaTbCA CMHEN, 3eNIeHON NN Kpac-
HOW HEeMOABMXHOWM TOUYKOM Ha 3KPaHe, HO 3TO He BAUAET Ha ero Npon3BOANTENIbHOCTb

BHumaHwue! MNogkniouainTe ycTpONCTBO TONbKO K pO3eTKe C 3a3emieHnem.
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1. OnncaHune ycrtpomncrea

1.1 Oco6eHHOCTM yCTpOMCTBa

> YNbTpaToOHKaA paMKa: pexrmM BULEOCTEHbI.

> Bbicokoe pa3pelieHune: cBoboaHoe MacliTabrpoBaHue sKpaHa.
> YnbTpawmnpokuin yron o63opa: granasoH ob63opa fo 178°.

1.2 QyHKUNN yCTPONCTBA

> MNoppepxka Bxoga 4K.

> Mopaepxka ¢yHKumm DP Loop (Display Port Loop).
> MNoppepxka nosopoTa Ha 90, 180 n 270 rpagycos.

> MoaaepKa MalMHHOMO Koga.

> (DyHKLlI/Iﬂ aBTOMaTn4yeckoro O6Hapy>KEHI/IF| CUrHana.

1.3 Cneyndukauun

[wnaroHanb (atoimbl) 55

Tvin naHenn ADS

PaspelueHune 1920 x 1080 (Full HD)
ApkocTb (Ka/m?) 500

KoHTpact 1200:1

Yrnbl 0630pa (B/T) 178°

CkopocTb peakuun (CaC, mc) 8

TonwmHa pamkm (KapTUHKa K KapTUHKe, MM) 3.5

MopTbl BBOAA

VGA, DVI-D, HDMI x2, DisplayPort, RJ45 (RS232)

MopTbl BbIBOAA

DisplayPort, RJ45 (RS232)

Fa6aputbl (BXLLXT, Mm) 1214x684x94
Macca (kr) 28
CoBmecTUMOCTb ¢ KpenneHuammn VESA 400x400
MouwHocTb (BT) 171
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1.4 NopgKknioyeHne cncTtembl

RE232

RS232

Signal Input

Video Matrix
Video Signal
CTpyKTypa cncremMbl
RS232 T
ouT
AC AL
220 DID 220
|

f

signal input “‘1:’:’4

!

1

RGB Matrix

l

RGB Signal

—

RS232
ouT

DID
2

Pt

signal input ““li"’-‘

t

R5232 RS232
ouT ouT
AC AC
220 DID 220 DID
3 4
signal input #5232 ; ; RS232
9 put™s signal input ™0

PC

RS232

bnok-cxema (2 Ha 2)
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1.5 YcTpaHeHune HencnpaBHoOCTEN

B cnyyae BO3HVMKHOBEHMA HEMCNPABHOCTN HEMEAJIEHHO OTKIIOYMTE YCTPONCTBO OT 3MeK-
TpoceTun. He nbiTaliTeCb CaMOCTOATENIbHO pa3obpaTh YCTPOWCTBO AJA MPOBEAEHUs PEMOHTA,
MHaye 3TO MOXeT NPVBECTU K aHHYNIMPOBaHMIO rapaHTun. Huxe npreegeHa tabnuua ¢ uH-
bopmaumeln 06 ycTpaHeHUN HEKOTOPbIX HencrnpaBHocTel. Ecnm ycTpaHWUTb HEMCNPaBHOCTb
CaMOCTOATeNIbHO He yfaeTcA, 06paTnTech B aBTOPU30BaHHbIV CEPBUCHbIN LLEHTP.

HeuncnpaBHoCTb

Cnoco6bl ycTpaHeHuns

Ouncnnen He BKNoYaeTcA
(MHBUKaTOp NUTaHUA He
ropuT)

1. Y6enutech, UTO NMMHUA NUTAHNA HE NOBPEXAEeHa.
2. MpoBepbTe, NOAKIIYEHO /N YCTPONCTBO K 31eKTPOCeTU.
3. Y6eputech, 4To BbIK/IOUATE b MUTAHNA HE MOBPEXAEH.

Bce BugeocTeHHble 610K
He paboTaloT AOMKHbBIM
obpasom

1. MpoBepbTe HaCTPOKM NOpPTa NPOrPamMMHOro obecneyeHns ana Buae-
OCTEHbI.

2.TpoBsepbTe, HET IV NOBPEXAEHWU B NOCNeA0BaTe/IbHOM KaHase, a
TaKXXe coefnHEHNE MeXay YCTPoncTBOM 1 nHtepdercom MK.

3. MpoBepbTe, HET I NPo6eM € nocieAoBaTenbHbIM noptom MK.

4. MpoBepbTe, NPaBUIILHO NI yCTaHOBNEH aapec 611oKa.

HekoTopble B1AeOCTEHHbIE
610K He paboTaloT JONMXK-
HbIM 06pa3om

1. MpoBepbTe, NPABUILHO NI YCTAHOB/IEH aapec 61oKa.
2. MpoBepbTE, MOXKHO N1 OTAENBHO YNPABATH O4HUM GIOKOM.

OrtcytcTByeT Bxoa VGA/DVI
A8 OfHOTO UM HECKOMNbKIMX
YCTPOWCTB

1. MpoBepbTe coefHEHVE MeXAY NNAaTON YCTPONCTBA Y UCTOYHNKOM
curHana.

2. U3amenuTe nunmio VGA/DVI gna nposepku.

3.MpoBepbTe, NnepeBefeHoO NN YCTPONCTBO BO BXOAHOW PEXUM.
4.Y6epunTech, YTO BXOAHON CUTHaM He BbIXOAMUT 3a NpeAenbl BXoAa
YCTPOWNCTBA.

5. ina Bxoga DVI nogTBeppauTe 3axBat DDC n Bbixog.
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2. UuTepdeinc n pasmepbl

2.1 Cneundunkaynm nurepPpenca

P & &= e &= @ @] ()

DViinput HDMIMHL ~ HOMI 4K DP Input VGAnput  DPoutput RS-232input RS-2320ut  AC INPUT
MopT OnucaHune
Bxop DVI Bxop nHTepdeiica DVI, no 1920x1080 60 Iy
HDMI MHL Bxog uudposoro curHana HDMI, go 1920x1080 60 Iy
HDMI 4K Bxog uudposoro curHana HDMI, jo 3840x2160 60 Iy
Bxogp Display Port (DP) Bxop undposoro curHana DP, fo 3840x2160 60 Iy
Bxog VGA Bxop aHanorosoro curHana VGA, go 1920x1080 60 Iy

Bbixog Display Port (DP)

MocnepoBatenbHbIN Bbixog DP, fo 3840x2160 60 Iy

Bxop RS-232
(pa3bem RJ45)

MocnenoBaTenbHbIN KOMaHAHbIN BXOL ANA AUCTAHLNOHHOIO
ynpasneHus

Bbixog RS-232
(pa3bem RJ45)

MocnepoBatenbHbIli BbIXOA ANA AUCTAHLMOHHOIO YrpaBieHuns

Bxop nepemeHHOro Toka

WcTouHuK nutaHmnsa
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2.2 BapuaHTbl pa3MmepoB yCTPOMNCTBaA

Mopgenb c guaroHanbio 55 gioimos, 3,5 mm
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3. MporpammHoe o6ecneyeHne

3.1 Pabouas cpepa

> OC: Windows98/2000/NT/XP/WIN7/Vista

> MuHumanbHasa KoHpurypauua LIMN: asyxbagepHbii, 2,0 Iy 1 Bbiwe

> MamaTb: 1 7B

> Bupgeokapta: VGA, otobpaxeHue 6onee 256 LiBeTOB

» Xectkuin guck: 10M

» NocnepoBaTenbHbIN NHTEPdENC CBA3WN: CTaHAAPTHBIN MHTepdelic cBA3n RS232 nnu co-
BMeCTUMana Mojesnb

3.2 3anyck nporpaMMHOro o6ecneyeHus

Mpexpae yem 3anyckaTb NporpammHoe obecneyeHue, ybegmrech, Uto
> nuHuA RS232 komnbloTepa Ans NporpamMmmMHoro obecneyeHus NpaBubHO MOAK/IOYEHA K
KOHTpoONepy;
> COOTBETCTBYIOLYME CUTHANbHbIE TMHUW KOHTPOMEepa U INHNA NMUTaHWA NOAKOYEHbI Npa-
BUJIbHO.
MNopAanok oencTeunii:
1. BknounTe KOHTpoONNep, NOC/e Yero 3aroputca MHANKaTop.
3eneHbln — 3aMnycK; OPaHXKEBbIN — OXKUAaHue.
2. PacnakyiTe apx1B C NMPorpaMmMHbIM obecneyeHnem Ana BUAEOCTeHbl. YnpasndtoLee
nporpaMmmHoe obecrneyeHue He TpebyeT ycTaHoBKM. 3anyctuTe Lcdwall.Exe (Puc. 1).

anIMeHaHI/Ie: BCe onepaunn 4ONXKHbI 6bITb OTKPbITbl B MoCnefoBaTe/ibHOM MOPTY.
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W LCD WALL = o X
Systern Setting  Lamguage Help

S SEEN u: ="m 2| G

Main Set Soresn OF  Sereen OFF  Fundtiog Set Soreen Addr Merge Valerge 'l’r.exe_ Eemote Lan reflesh Balling Text

TN set

[ Auta Open """"U

Ingut syures

Input seures [0 =F =
Input Ha I* -| Eemasa i
I~ Natrin Enable Executs

Watriz Type
HOBGENEG_ MM

B 4
28 USE

™ Mix Matwix

Open COM | 4 |

| |

Fover m | Foser off |

[,-'l-sﬂ... hﬁuk‘i‘.“tu‘hiuliln s.:-|

Blay: [Fote: - = ]

LT — '
| & Ea s

= —J i

P Border 285uce B

[
[
[

{Cam Closed “20m1-12:27 143852 Operstor

Led L L)

EIVRITITG,

Puc. 1

MpuMeyaHme: cofepxmmoe nHTepdernca MoXeT OTINYATLCA OT MPUBEAEHHOTO Bbille Nprime-
pa c opyrovi Bepcreii NPOrpaMMHOro obecneyeHus.

OnuncaHue yHKUMi nHTepdeiica (Puc. 1):

> Pabouas 30Ha: Kaxblll SNeMeHT CETKM NpefCcTaBNAeT COOTBETCTBYIOLMIA KOHTPONMPYEMbIN
3KpaH, Bbl MOXKeTe Bbl6paTb COOTBETCTBYIOLMI KOHTPONIMPYEMbI 6NOK, LeNKHYB N0 HEMY 1
nepeTaLimBe.

> 30Ha PYHKLMI: COAEPXKNT YaCTO UCMONb3yeMble GYHKLMOHaNbHbIe KHOMKMW.

> 30Ha 3aronoBKa: NnoJib3oBaTesNlb MOXET M3MEHATb OTOOPaXKEeHME 3arofioBKa B COOTBETCTBUN
CO CcBOUMMU NOTpebHOCTAMM.

> 30Ha COCTOAAHUA: OTOOPAXKaeT COCTOAHME MOPTA, a TaKXKe TeKyllee MeCTHOe Bpems, AaTy U T. A.

3.3 HacTpoikn nporpammHoOro o6ecneyeHuns

1. WenkHuUTe No pyHKLMOHaNbHOM cxeme «HacTponkmu nocnepgoBaTenbHoro nopta» (Puc. 2).
2. [ina aBTomatmnueckoro noaknoyeHna COM HaxmuTe KHoMKy «Refresh» (O6HOBUTL), a
3aTem HaxmuTe «Open» (OTKPbITb), YTOObI YCTAaHOBUTb COELIMIHEHNE.

COM zet

|come |
[~ Auto Open Refresh

Open COM

Puc. 2
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> CTpOKI/I B pa3sgene «I'Iapameprl avncnnes» yCtaHaBIMBalOTCA B COOTBETCTBUN C (I)aKTVILIeCKVIMVI

noTpebHOCTAMN.
> Hanpumep, 2x2 B XP.
» Ecnv 6noK nmeet pasmep 2x2, BUAEOCTEHHbIV MacCyB fOMKEH ObITb YCTaHOBNEH Ha Ancnnee

2x2.

3.4 HacTtponka ngeHtudpukaropa yctpomncraea

Bce o6opynoBaHue nmeet ID-Homep 1, nonb3oBaTenb JOMKeH YCTaHOBUTL ID-HOMep anc-
nnes B COOTBETCTBUM CO CBOMMU NOTPEOHOCTAMU.

1. Tlonb3oBaTtenu ¢ NnpaBamn agMUHKUCTPaTOPa BBOAAT NapaMeTp «Agpec aucnnesn».

2. [nAa Kaxporo mMalMHHOrO Kofa Ancnnesn BBeguTe COOTBETCTBYWMIA ID-HOoMep.

3. Haxmwute «Modify» (MU3meHnTb), UTOOBI 3aBEpWNTL NpoLecc u3meHeHus ID-Homepa

ancnnes.
-
. ==l
ween OH Sereen OFF Functiog Set Sereen Addr Merge TnMer ge Fresrs
Mac Kep
Parel Urit 1D Change
Display Mackey | Display ParellD |
Matriz In: O
Puc. 3
Mpumeyannsa:

> Mpu cmeHe ID-HOMepa cUnTaTe MalUVHHbIV KOA, OTOOpaXKaeMblil Ha SKpaHe, 1 U3MeHuTe

cooTBeTcTBYOWMN ID-HOMep gucnnes.
> KHonkKa «System Settings» (HacTponku cncrtembl) CTaHOBUTCA aKTUBHO TOJIbKO Mocsie

BBOJa Naponsa agMmHUCTpaTopa.
> [Maponb agMuHucTpaTopa no ymonyaHuio — 111111, Bl moxeTe U3MEHUTb ero.

3.5 Bbi60op BugeocTeHHbIX 6/10K0B

Bbl MoXeTe BbIOpaTh OAUH UMM HECKONbKO BUAEOCTEHHbIX AUCMEEB, @ TaKXKe YCTaHOBUTb
BXOAHOW CUrHan, WeKHYB NPaBo KHOMKOWM MbIlK, Nn HaxaTb «Freeze» (3amopo3nTsb),
4YTOObI 3aMOPO3UTb TeKyLLee N306paKeHUe, N HaxKaTb KHOMKY elle pas, YToObl OTMEHUTb
3aMOPO3KY.
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W LD WaLL - a ®

System Setting  Language  Help

Se SEEIN iz == 22 | O

Main St Serewn O Screen OFF  Functing Set Scrasn addr Harge rlar s Frosse Reaots  Lan raflash ﬁuuu; Tast
z T zat-
HOAT fr———
Matrix In: 1 | =l
T Aste Dpen Refreah
Ingut sewres

Toget vewres B0 =] f =
Tngut: Be 1 - EJ

¥ Matrix Enable Exesute
Harriz Typs
[ Hin Watrix
Open o | Y I
Ponaran | Fover oft |
¥ ordar Bffect [ Matrin Ceafig | B0 Sceme Froset | I Combination Set |
Matrin Tope hddr Dalayi [I50ma = |
AV SE15_AV - i ] =]

el = R
5 ,—j — o

3.6 O6bvegunHeHne

[inA HeCKONbKMX BUAEOCTEHHbIX AVCMIEEB, HAMPUMep 2 Ha 2, noce Bbibopa 3KpaHa 4
BblOepuTe NCTOUYHWK CMTHANa 13 CMCKa MCTOYHUKOB CUTHAMA, a 3aTeM HaXKMUTe KHOMKY
«Execute» (BbinonHUTb), UTO6bI 3aBepwINTb Npouenypy. HaxxmunTte KHonky «Image Freezing»
(3aMop0o3uTb N306paxeHne), YToH6bl 3aMOPO3UTL TeKyLee N30OpaKeHNE, N HAXKMUTE KHOMKY
ele pas, YTobbl OTMEHNTb 3aMOPO3KY.
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= 1D WaLL
System Setting Language Help

b OON 219

Adwin Main St Soresn 08 Soreen OFF Fanotiog Set Sereen Addr Herge Tnffer g Freeze Besste  Lan raflash mhu Taxt

0N set

__.:"
I™ hute Open Bafrosh
Lrput soures
Trput sourcs [0 2
Tngut Fo: |4 | anems |
™ Matriz Bnable Exveste

Matrin Type
HBGE_HTMET
™ Wiz Matrix
Gpem 08 | Clesecm |
i P | oo |

P Bocder 2ebace [ Watvin Confic | Scone Pronst | I Conbinaticn St |

Matriz Tupe hidr Daluy r-ﬁ s s
w Fer B | e

wr ok | i o] of (T EomeRkie
oo T {l ] || esies
Puc. 5

Mocne o6befnHeHNA Mexay aucnneamm 6yayT webl, HaxmuTe «Eliminate the border»
(YcTpaHnUTb rpaHULbl) U YCTAaHOBUTE COOTBETCTBYIOLIME 3HAUEHUs!, UTOObI clenaTb n306pa-
>KEeHMe CroLWHbIM.

W LCD WaALL - =] x
System Setting  Language  Melp
He g B¢ T = ¥
. - = |- S
Enin Set Soraen O s-rem QOFF  Functing Set 5='uﬂ| \Jir Werge elar ga Fresze Fenoke Las reflesh Balling Test
O xet
™ hute Open Bufrash
S i

Ingut souras

Input souras E j j I
Input Ho fn - j
I~ Watris Enahle Execute

Uatriz Trpe
OMGEDEG_ T

™ Mix Matrin

| |

& satrin Config | Somna Prosst | I Cosbination Set |

 Bordar faa) Sa
H 5 v F
Cam Closed I j0a11z-27 16T Operator

Puc. 6
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MpumeyaHue: 3HauUeHNe pamMKy YCTaHAB/VMBAETCA B COOTBETCTBUN C GpM3NUYECKON PaMKO
3KpaHa. Ha puc. 7 nokasaH addeKkT yaaneHusa pamku.

OyHKLMA yAaneHna paMKu He NpyMeHeHa OyHKLMA yAaneHna paMmKu NprmMeHeHa

Puc.7

3.7 Bbi6Op NCTOUYHNKA CUrHana

BbiGepunTe NCTOUHMK CUTHANA 1 HaXXMUTE KHOMKY «Execute» (BbINONHWTD).

" LCDwall - o x
System Sefting  Language  Help

S BEEBN :="m = | O

himin Maiin Set Soween OF  Soveen OFF  Punctiog Set Sereen Addr Warge rler ge Fraeze Remate Lan reflesh Relling Temt

T vt
=l
™ Mats pan Bafrash

Ingrub oercs

Tagat swrn I =] [ =]
Tnpat Ho |- S Bates

MO 4K
[ Hatrix lnh{;p

Ratrin Tipa LoD

MI0_¥oA
T~ Min Matriz

e |

B ecdue éfect | Q) Mateis Conéiy| B Sevan 7razee | B Conbination Sot |
# Burdar (o) Eat
" E v F
Puc. 8
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3.8 BknioyeHune maTpuubl

1. Haxkmunte KHonKy «Matrix Enable» (Bkntountb maTtpuuy) n Bbibeprte HOMep BXOAa MaTpuLbl:

W (COwaALL - E
| gystam Setiing Laﬂgnage

| T
ar [+ e o B - ¥
o= PN | s )
l.m. Sat  Screen 0 Serewn OFF Functlog Sat Seran ld.df Marga e gu Fraate Beacts  Lon reflesh Bolling Tase
I Z O st
DKL [Fre -

1™ huke Opan Kefrash
Trgue oures

Zagus sawren (M2 =ik =
Izguz ¥a 1 =

™ Matriz Enab

r
L X Batriz Type
SHS_ ¥

I~ Nix Matrin

open com | o |

Four on | Fowar aff |

P bocder Bifeor B Matrix Confic | B Soenn traaat | B Cobination Sat |

Mg [ o e
LTI |

= i
o] T =zl e K L
= — @ fraaeits

Puc.9
2. BbibepuTe TMN MaTpuLbl M yCTaHOBUTE NAeHTUMKATOP MaTpULibl.

MpumeyaHme: pa3Hblil BbIGOP MaTPULbl UIMEET Pa3HYI0 3alepKKy BPEMEHM.

- LD wiALL - o X
Systom Setting  Language
& -E!.E!. et |
= 4
| Main Sat Serasn O Serawn OFF Funotlog Set Soreen M Wargs Uil gu Fraage Bemots Lan tiﬂ-lh IM“.III‘ '[Ill
2 OO sat
EDKI
[ o
[~ te Open Kk b
Trput vourse
Tagit $iiren P2 =1pF =
| Ixguz ¥a 1 ] e |
| e
| o [~ Matrix Enable_Erssuts |
1 EDHI ) ="
| Matriz Type
SHS_ Y
I~ Mix Watris

open com | .|
(P HEMT | S e oy |

—— oo | |
¥ Darder urm Soesa Prazat | [ Coabisation Set |
! Ml [F =] o
Ay =l
| o =l - Pt
; W [ = il R CUN




3.9 NpeaBapuTtenbHaa HaCTPOMKa CLEHbI

> MNopgoepxuvBaeT 16 BUAOB CLEHbI, UMEHA KOTOPbIX MOXHO M3MEHATb.

» YT06bl COXPaHUTb CLEeHY, HaxkmuUTe «Save Scene» (CoxpaHnTb CLUeHy), 1 moaens byaeT
coxpaHeHa.

» YT06bI 3arpy3nTb COXpaHeHHYyIo cLeHy, HaxkmuTe «Load Scene» (3arpy3unTb cueHy).

> PeXxum onpoca cLleH MOXHO 3anyCcTUTb B COOTBETCTBUM C NOTPebHOCTAMU Nonb3oBaTens.

-
System Setting  Language  He
S [ BN ke '.! bl D)
! = d aa -' r
Adain Bl Sat Eeraen OF Seraun OFF Fumetiog Set Scraan hdde Urlex gu !rnu Banobs La= r-il-ﬂ. Rnllm[ Tazt
OO gt
o x
its Open ;..&..LJ
Scene Flok Polng
Soene Select | saurce
| __zc:;n'us;_"'_m"';aa__';;{}i" o (I T
| e scmre scere
| scened scenel scenel scerels Y ] e |
|2 sconst scanedt scerel? | sconwlf * -
riz Eaabls Evecute
IntevalsSel - [5 F | (T
[~ Seans Al Polrg Ensbied ik
x Watrin
Save |

toew an | towwr off |

B Berder Bffert | B Mutvin Config I Coshination Sat |
[foxne Prenad]

Puc. 11
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3.10 HacTtpoukn NO

1. HaxmunTe KHonky «Admin» (ABMUHMCTPATOP) 1 BBEAUTE Naposib aAMUHNCTPaTOpa
111111 BO BCN/bIBaKOLWEM AMAJTIOTOBOM OKHe.

-
mlem Seging Langusge Help
g il & bz - ¢
] a4 - ™ \Qi} X i
hdsin ks St Berwan 08 Serawn OFF Funotieg Sat Soreen hidr Marge !nu- Hamets Ean vaflesh Belling Taxe
u‘ 53] z CON pat
I B} ot HOAI T
Matriz In: 1 Batriy In: 1

I bty Gpan Rafrech

i Tmput womce
Admiristrator x
Tagns soeres O = =
Adninistrater parword (3] Login | Input Bo: |1 <] B |

| Q # Ratrix fndle Tzwcuts

Wntrin Type

i ,..—,a\ e | MIHIHG, IR
I Mix Matrie
Password: 111111 T
ke Mjurr. |

Fover on | Ponur aff |

BE berder Bifest B Mateis Conic |£l I | W Cotination S-tl

Batriz T Al Dwy: [ -] W
e T = ]

" — || emenik
= * Bt

Com Closed 2021-12-28 0%:08:14 Chperator

Puc. 12

2. HaxkmuTe KHOMKy «Main Set» (OCHOBHble HAaCTPOWKM) 1 yCTaHOBUTE CleaytoLyme NapameTpbl BO
BCMJIbIBalOLLLEM AVANIOTOBOM OKHE:

W LoD WALL

o x|
System Setting inge  Help
Adnin Sermam I8 Servan OFF  Functiog Set Serem IH.r Marge Frasta Ranoks Laa ruﬂn.l Balling Text

2 8 sut

Bt 3

Matrix In: 1
[~ duste Opes Befresh |
Trqut wanres

Toput earce TRE s =
Ingut B i v] Rememe
JNI ;DII ¥ Matrin Esable Exesuts 1

i : 5 o Hatriz Type-
atriz In: 1 Matriz In: 1 I

™ Mix Marrin

[ ] |
At Rdjust

Fesran | Fovur off |

¥ torder 2htee [ Matrl Confic]| ] sane Peases | B Conbinabion Sat |
Wairly Typs Adde Dlay:  [ias =] Watrix Outgus Sas I'
W JEER = ok [ A Marie e com oy <]
Woa.  FUOVSL S8 OE | Vek Mateix Use cotot] ] B g
v [EESIEC ST o | [ I Matrix Use coM 0] =] 2 bt

Com Clased 2021-12-26 090512 - M’_}_ S T |
Pnc. 13
- 72 -




L O

el L BT

Adnin Wiin et Serwsn OF  Seresn OFF Funebiog 54t Serawn ddde Baign Vel o Franea Bémsts  Lun uflesh Balllag Tawt
1 2 O sat
HIMT HOET =i
Matrixz Inz 1 =
Adjwst Objast I~ huta Dpem Bafeash |
™ ¥idew r Adjet Rangu 0, = 0.1

| #unad | Input swared
ey
Inpub swwes L =] =]

Bansas

Picturs | Guematry | Color Teap | Systam | Fan

Brightness J J
Grine ==

Tagut Fao L =l

@ Matris Snakly Mremute |

Batriz Ty

Colar J J HINGRDNG M
Sharpress '_] = ] ™ Min Matrix
we -] ¢ _Crlm bt | Gac | ]

bt djust |

it
| Fover an | Fover oif | |

BY Border Effect (B Mubris Confic ] Soene Froset | I Cosbination St |

Watris Type  hddr e Matrix Output Sar |
wo FEA =B k| T meisvecoods] <) G
v [0V =0 COE| T WA Matris Ues 0O w =) L | © L
wy  [OPRDR A 8 0K | [ OVD Batriz Use 0Dl ) il b L]

2021-12-28 09:18:06 Admiristrator

Puc. 14

Com Closed

MpumeyaHume: 4OCTYN K HACTPOKAM MMeET TONIbKO aiMUHUCTPATOP.
B 3TOM MeH10 ABa napameTpa «Video» n «VGA» onpefenatoTca pasHbIMU NUCTOYHUKAMU CUT-
Hana; KaXk[as U3 HaCTPOeK B BUAEOCTEHHOM 6510Ke 6yaeT oTobpaxKaTbCsA COOTBETCTBEHHO.

3.10.1 HacTtpoika nso6paxxeHus

Ecnun B 6noke «Adjust Object» (HacTpouTtb 06beKT) Bbi6paTh NapameTtp «Video», MOXKHO
HacTpouTb napameTpsbl «Brightness» (ApkocTb), «Contrast» (KoHTpacT), «Color» (LiseT),
«Sharpness» (Pe3kocTb), «Tint» (OTTeHOK) 1 Color Restore» (BocctaHOBNEeHMe LUBeTa).
Ecnu B 6noke «Adjust Object» (HacTponTb 06beKT) BbibpaTh NapameTp «VGA», MOKHO
HacTpouTb NapameTpbl «Brightness» (ApkocTb), «Contrast» (KoHTpacT) n «Color Restore»
(BoccTaHoBneHwMe LBeTA).

Settiing \
Adjust Object mbe T8
 Video © vea Adjust Range 0,1 - 0,1 T | | M B 5
(BLEBis ) Geometry | Color Tenp. | Systen | Fan | Panel | LT TTIN ) (R A L I O I/ |
Brightness ~ @ Er: fharaaa
Contrast - + i Bk gty
Color - i —aler
Sharpress  — + shurpraa
Tint - * Color Restore T . T FEEE )
Exit ik
Puc. 15
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3.10.2 HacTponkKa reomeTpumn

Ecnu B 6noke «Adjust Object» (HacTponTtb 06beKT) BbibpaTb NnapameTp «Video», MOXHO
HacTponTb napameTpbl «<HPosition» (TopnsoHTanbHoe nonoxeHune), «Hsize» (Topn3oHTaNbHbIN
pasmep), «VPosition» (BepTnkanbHoe nonoxeHune) u «Vsize» (BepTrKanbHbI pa3mep).

Ecnu B 6noke «Adjust Object» (HacTpontb 06beKT) BbibpaTh NnapameTp «VGA», MOXKHO Ha-
cTpouTb NnapameTpbl «HPosition» (Topr3oHTanbHoe nonoxeHwue), «VPosition» (BepTukanbHoe
nonoxeHue), «Clock» (4actoTa) n «Phase» (Pa3a).

—  |swning % |
:@5&”"1 A RAJRIT RLM ol = o f't-"'i‘::’;m = Ex Adzuck Sage 1 =01
Foizera LAsTATrY |_¢'_¢.- aamp |z [ re [Pl | Zickow VesmeRt Uil Twg | ook | Do ETA
e o - M. rijeas m = | J AN aduck
biiza 1 - L8 WY = = J | Smoald. = | + |
L a=irab) S - i#aEi bisa J + | L | b |
"o [ N3 = o J J AL, - | o |
an ]
H|E S
S a L5
Pnc. 16
MpumeuaHune: Hactpornka ADC HegocTynHa.
3.10.3 TemnepaTtypa uBeTa
Ona napameTpos «Video» n «VGA» MOXHO Bbi6paTb 6anaHc 6enoro.
tistting 7 V 5 :"'"i"E &
Adsack Wazask 'f"i“-i Lo —_— ‘e . .
" didur o adrack Sapu -l b L RAIIT RN LD Tl
Zivkon | demnbs Vil Tug sk | sa | Sead T R A P e L |
CIE CRTTT) LI T FTTR
ol JJ G ' =t ' LIRS O | L
Liihe ' Lol (e £ ' ,AF
"'""JJ AT v \ 000 P | rae ||
e ] "
I | 98
" e
Pnc. 17

3.10.4 HacTpounka cucrembl

B meHto «System» (Cuctema) MOXXHO HacCTPOUTb APKOCTb NOACBETKU, PEXMM CUHEro 1 YepHO-
ro 3KpaHa, 0O6HOBNEHVe NPOrpamMMHOro obecneyeHus, aBTOMaTUUYECKYO HAaCTPOIKY No3nLmm
VGA v uBeTa.

-74 -



i didee i Adaek Swmpll | =01

Sizkes | vamskn | Ulie Tuag 0ot [ fe | e |

Fusdli gk Jd - #

[ | Fuezary baaas |

PR T |.|-| Boge o0 %o B |

Az vz s | A sz e | Auzdi gk e

5

Puc. 18

» Backlight: ncnonb3yetca gna perynmpoBKy ApKOCTU NOACBETKM.

> Auto ADC: ecnu 3HaueHue, nonyyeHHoe B pexkume VGA, ABNAeTCA HENPaBUIIbHbIM, 1 LBET
oTo6paxaeTca HemnpaBUIbHO, HAXXMUTE 3TY KHOTMKY, YTOObl MOBTOPUTL MOMbITKY.

> Blue Screen On: npu Ha)KaTuKM 3TOM KHOMKM BKOYAETCA PEXUM CUHETO 3KpaHa, 1 Koraa
HeT CUrHana, 3KpaH CTaHOBUTCA CUHUM.

» Black Screen On: npu Ha)kaTuy 3TOM KHOMKW BKTIOYAETCA PEXMM YEPHOrO 3KpaHa, 1 Koraa
HeT CUrHana, 3KpaH CTaHOBUTCA YEPHbIM.

> Factory Reset: HaxXmMuTe 3Ty KHOMKY, YTOObI BOCCTAHOBWTb 3aBOJCKME HACTPOMKM.

3.10.5 Appec sKpaHa

o QIR |==m 2 | ¢

n in Maip Swt  Sorsan OB Sevwen OFF Functiop Sofl Screan Addr Bargs r.—.m Bemate  Lam .—.H.A B(llu\‘ Text

i
FoaT
Natriz In: 1

—=

S Parel ID cat [ dutn pen Eafrash |

Inpat sewren
kb gt seurce ML =p =
Pl | then | Tgatdt 1 v Tanams
i 1 eete
o Depley Wik | Disglay Panl D | 2 Matrin Ensbls "“_“J

Uatziz Type
HOBETING_HIR

Matriz In: 1

[~ Mix Metrin

Open OO Close o |
Auts hdjunt - I
el

| Fovur aff |

Puc. 19

HaxmuTe «Screen Add» (Agpec skpaHa), NOABUTCA BCMbIBalOLEe OKHO, KaK NMoKasaHo Ha puc. 19.

Puc. 20
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Bce BMpeocTeHHble NaHenn MMetoT 3aBOACKOM agpec 01 01, nonb3oBaTeNib MOXeT YCTaHOBUTb
ajpec B COOTBETCTBUN CO CBOMMUA I'IOTpe6HOCTﬂMI/I.

Cnocob HacTponku:

1. OTob6pasnTe MalUUHHbBIN KOA SKpaHa BHM3Y 3KpaHa, Kak NoKasaHo Ha puc. 20.

2. HaxmuTte «Screen Add» (Agpec 3KpaHa), NosABUTCA BCMIbIBaloLLee OKHO.

3.  YctaHoBuTe agpec s3kpaHa u Haxmute «Modify» (M3meHUTb), UuTOObI 3aBEPLINTL U3MEHE-
HWe agpeca.

3.10.6 O6HoBneHne NO

1. Ckonwupynte MERGE.bin B KopHeBoil KaTanor USB-HakonuTens, He n3meHas nma daina.

2. Bcrasbre USB-guck B USB-nopt gucnnes.

3. HaxmuTe KHoMKy «Software Update» (O6HOBMTb NporpammMHoe obecrneyeHue), Kak no-
Ka3aHo Ha puC. 21, 3KpaH CTaHET CMHUM, NPOorpecc 0OHOBNEHWA NPOrPaMMHOro obecrne-
YeHus oTobpa)kaeTcs B BEPXHEM MPABOM YIiy, a UHAVKATOP NUTaHUA nooyepenHo byget
MUraTb 3eN1eHbIM U OPaHXeBbIM, MOCIIe Yero o6HoBNeHNe ByaeT NPUMEHEHO aBTOMaTK-
yecKu.
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MpumeyaHme: He BbiKJIlOYalTe NMTaHUE U He oTcoeauHsanTe USB-Anck Bo Bpems o6HOBIe-
HUA, NHaYe 3TO MOXKET NPUBECTUN K MOBPEXAEHMIO YCTPONCTBA.

3.10.7 HacTponka BeHTUNATOpa

OT1a GyHKUMA HeJOCTyNHa B LAHHON MOAeNMN.
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3.10.8 HacTponka naHenu

Cm. puc. 22.
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3.11 HacTtponka ¢pyHKuMIA

1. HaxmuTe KHOMKy «Admin» (AAMUHMCTPATOP) 1 BBeAWTE Naposb afMUHUCTPaTopa
111111 BO BCNAbIBAOLWEM ANANTIOTOBOM OKHeE.
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2. HaxmuTte kKHOMKy «Function Set» (HacTpolika dbyHKLMIN) 1 ycTaHOBUTE Crieaytowue
napameTpbl BO BCMJIbIBAOLLEM ANANTOTOBOM OKHeE:
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3.12 YcTtaHOBKa Ha3BaHunA

HaxxmuTe «System Settings» (HacTpolku cuctembl), a 3aTeM BO BCMJbIBaOLLEM ANANIOTOBOM
OKHe HaxmuTe «Title Set» (YcTaHOBUTb Ha3BaHue).

& LD el 2 =] =
System Setting  Language Help

Admin
=~ N s -=m 2| &
Furictiog Set a4 -
Thie Sai Sevewn OR Soreen GFF Fmctiog St Sereen dddr Urltarge Franes Ramats L reflod Balling Tast
Rl Polling = e
Color Adjust FONI [ S
S Matriz In: 1 =
™ dnto Opex afeasd |
Ingat searer— = —
Trpat soarse (77 =k =
Tnput e 1 =] B |
B g ;-..- ¥ Matrle Bnably Eecute
hi. b3
3 < iz Tn: Yatrix Tipe
atrix In: 1 Matriy In: 1 B2, 1T
I iz Matris
Opan OO Chema TN
huts hdijuzt
Poar an | Porar off |
P¥ dorder zefect | Matris Config ]| [ Soma Freaet | M Conbination St |
Matrlx Typs Al Dabay.  [1%0ws ® Matriz Outpat Sat
w [ =B oR | AV Matrin Use CON Only -
wa  EOWR <P OK | T e Mutvix: Vea OO Oul] : M aaddain
pvr.  [OSSECEECeIP 0K | [ OVD Mawris Vs OBOS | T e
Com Cloted 20271-12-29 10:46:38 Administratos
Puc. 25
8 Tide Set - o ®
Title
JLEDwsLL Change
Uses Name
||| e Compary Hame
Compary ‘Webaite
I Chsngs
Uses Logo
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> Title: nonb3oBaTenb MOXET U3MEHUTb Ha3BaHVEe B COOTBETCTBMMN CO CBOVMMU NOTPEBHOCTAMN.

> User name: nosib3oBaTtesib MOXeT U3MEHUTb MA NOJib30BaTeNA B COOTBETCTBUN CO CBOMMU
noTpebHoCTAMM.

» Company URL: nonb3oBatenb moxeT n3meHutb URL-agpec B cOOTBETCTBUM CO CBOMMMA
NnoTpebHOCTAMN.
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» User LOGO: nonb3oBaTesfib MOXET M3MEHWTb JIOFOTUM B COOTBETCTBMM CO CBOUMMU NOTPe6-
HOCTAMMU.

MprmeuaHue: OTKPONTe yrnpasnsioLlee NporpaMmMHoOe obecrneyeHne, WeNKHUTE B HYXKHEM
nesom yriy obnactu JIOTOTUMA. Haxxmute «Open» (OTKpbITb), YTOObI MOAKNIOUNTBLCA K yCTa-
HoBneHHomy URL-agpecy.

3.13 Bbi6op A3bIKa

34ecb nonb3oBaTeslb MOXeT BblOpaTb A3bliK M10.
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4. MocnepoBaTenbHOCTb NogKAueHun nHrepgenca RJ45
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5. MynbT ANCTAHLNOHHOIO ynpaBieHnA

5.1 MynbT AUCTAHLNOHHOIO yNpaBAeHUA

Puc. 29

5.2 UK-npunemMmHMK

NK-npremHrK Heo6xoanMo NOAKUMTb K 3KpaHy 1 nocnepoBatenibHON Lenu yepes nopt RJ45 IN.

5.3 HacTtponka agpeca s3KpaHa

1. Haxkmute kHonKy «MENU» (MEHIO) Ha nynbTe AncTaHUMOHHOIO ynpaBieHna, NOABUTCA Clie-
aylolee OKHO:

Input HDMI2
Brightness 100
Contrast 100
Backight 100
Saturation 98
Sharpness 2
Volume 50

4 9 < D>

Puc. 30

HaxmuTe «Input» (Bxoa). Hanprmep, ecnu ncnonb3yetca UCTOYHMK curHana «HDMI2», Bbibepu-
Te «<HDMI2» c nomoLbto KHOMOK «BneBo» u «BnpaBoy, 3atem Haxkmute «MENU» (MEHIO), utobbl
COXPaHUTb U3MEHEHNA.
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2. Mepenpute Ha cTpaHuyy «MachineCode» c nomolblo KHONoK «Bneso» 1 «Bnpaso»
B 3KPaHHOM MeHIO.

Machine Code 26047
Ten Thousands 2
Thousands 6
Hundred 0
Ten 4

Puc. 31

YctaHoBuTe «Ten Thousands», «Thousands», «<Hundreds», «<Tens», «<Ones», 3aTeM HakmMuTe
«MENU» (MEHIO), uTo6bl COXPaHUTb M3MEHEHNS.

3. Mepenpute Ha cTpaHuuy «Video wall matrix setting» c nomoubio KHOMoOK «Brneso» 1
«BnpaBo» B 3KpaHHOM MEHI0.

Unit ID 1
Merge Mode

Start Row 1
Star Col 1
Start Row 2
Star Col 2
Counter Row 2
Counter Col 2

4 9 < D

Puc. 32
Ecnu Bbl XOTWTe HaCTPOMTb MaTpumLy 2x2, ycTaHoBMUTe «Start Row» (HauanbHaa cTpoka) Ha
«1», «Start Col» (HauanbHbIi cTon6eu) Ha «1», «<End Row» (KoHeuHas cTpoka) Ha «2», «<End
Col» (KoHeuHbIn cTonbel) Ha «2», «Counter Row» (BcTpeuHas cTpoka) Ha «2», «Counter Col»
(BcTpeyHbiin ctonbew) Ha «2». «/igeHTUPrKaTOp YCTPONCTBa» — 3TO TEKYLYMIN HOMEpP Pacnono-
XKeHuA MaTpuLbl SKpaHa. YCTaHOBUTE COOTBETCTBYIOLW NI MAEHTUUKATOP, 3aTeM YCTaHOBUTE
Ons pexuma obbeanHeHna 3HaveHne «<Merge», a 3atem Haxkmute «MENU» (MEHIO), utobbl
COXPaHUTb M3MeHeHUA. Ecnn Bbl XOTWTe BbIATY U3 peXxrMa MaTpuLbl, yCTaHOBUTE ANA pexrmMa
obbeanHeHns 3HaueHne «<Normal».
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Mpounssogutens: Manug Jiumntepn. Agpec npounssogutena: opuc/kab. 9, 25/O KoHkopgua
Mnasa, 1 CanHc My3suym Poya, Tcumwatcyin, KoynyH, TOHTKOHT.

Nmnoptep B YkpaunHe: UM «JIOTUH». Agpec nmnoptepa: yn. Mapka Bosuka, 18A, 1. Knes,
04073. MaTepuan: nnactvk, metann. CooTBeTCTBYeT Tpeb6oBaHUAM AENCTBYIOLWErO CAaHUTAPHOrO
3aKoHoAaTenbcTBa YKpauHbl. He TpebyeT cnewmanbHbiX YyCNOBUIA XPaHEHWA.

[apaHTUIHBIN CPOK: 36 MecALeB.

Cpok cny»6bl: 5 neT ¢ gaTbl NPoAaku.

MpownsseneHo B Knutae.
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WARRANTY CONDITIONS

Dear Customer! Thank you for buing the 2E product that has been
designed and manufactured in accordance with and complying to the
highest quality standards.

We ask you to keep the warranty card during the whole warranty
period. When purchasing a product, ask for a complete filling in of the
warranty card.

1. The Warranty Card is valid only if the following informationis correctly and clearly stated: model,
serial number of the product, date of sale, warranty period, clear seals of the company-seller,
signature of the buyer.

2. Service life of the product is 60 months.

3. The product is intended for domestic use only. When using the product in commercial
conditions the seller/manufacturer does not bear warranty obligations, the service is carried out
on a paid basis.

4. Satisfaction of the customer’s claim due to the fault of the manufacturer shall be made in
accordance with the law of «On Protection of Consumers’ Rights».

5. No warranty is given with respect to any consumer violation of the operating rules set forth in
the instructions.

6. The product warranty service is cancelled from the in the following cases:

«  use for other purposes and not for consumer purposes;

*  mechanical damage;

» damage caused by the ingress of objects, substances, liquids, insects into the product;

«  damage caused by natural disasters (rain, wind, lightning, etc.), fire, household factors
(excessive humidity, dust, aggressive environment, etc.)

» damage caused by non-compliance of power supply parameters, cable networks with state
standards and other similar factors;

* in case of violation of the seals installed on the product;

« ansence of serial number of the device, or inability to identify it.

7. The plant guarantees normal operation of the product within 36 months from the date of the
sale.

* Tear-off maintenance cards are provided by an authorized service center.

The complete set of the product has been checked. | am familiar with the
terms of warranty service, no complaints.

Buyer's signature
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YMOBW FAPAHTIMHOIO OBC/1TYTOBYBAHHA

LWaHoBHuin Mokyneuyb! Bitaemo Bac 3 npna6aHHam Bupoby 2E, akun
6yB po3po6aeHuit Ta BUrOTOBJIEHWUI Y BiANOBIAHOCTI 40 HABULLMX
CTaHAApTIB AKOCTI.

Mpocumo Bac 36epiratn TaNIoH NpoTArom rapaHTtinHoro nepioay. Mpu
KyniBai BUpo6y BUMmaraiite NOBHOro 3aroBHEHHS rapaHTiliHOrO TaJIOHY.

1. FapaHTiliHe 06CyroByBaHHs 3/iMCHIOETLCA INLLE 3@ HAasiBHOCTI NMPaBWJ/IbHO i UITKO 3aMOBHEHOTO
OpWriHaNbHOIO rapaHTIMHOIO TaNoHy, y AKOMY BKa3aHi: Mozesb BUpOby, AaTa Npogaxy, cepin-
HWIA HOMep, TEPMIH rapaHTIHOro 06C/TyroByBaHHs, Ta neyaTkn GipMu-npogasus.®

2. Ctpok cny>x6um Brpoby cknazae 60 micauis.

3. Bupi6 npu3sHayeHnin 4ns BUKOPUCTaHHSA Yy CMOXMBYUMX LisX. Y pasi BUKOPUCTaHHSA BUPOOY B
KOMepLiiHIi AifNbHOCTI NpoAaBeLLb/BUPOBHMK He Hece rapaHTiHUX 30608 ‘A3aHb, cepBicHe
06C/1yroByBaHHsA BUKOHYETLCA Ha MAaTHIVi OCHOBI.

4. TapaHTINHWIN PEMOHT BUKOHYETbCA BNPOAOBX TEPMiHY, BKa3aHOro B rapaHTiiHOMY TasloHi
Ha BUPIi6, B yNOBHOBaXXEHOMY CEPBICHOMY LIEHTPI Ha yMOBaX Ta B CTPOKM, BU3HAYeHi YUNHHUM
3aKOHOZAABCTBOM YKpaiHw.

5. Bupi6 3HiMaeTbCA 3 rapaHTii y BUNaAKy NopyLIeHHs CroXuBayemM npasua ekcryatalii, BUknage-
HWX B IHCTPYKL,iT KOpUCTyBaya.

6. Bnpib 3HiMaETbCA 3 rapaHTinHOro 06CNyroByBaHHA y BUMNaAKax:

* BUKOPWCTaHHS He 3a NMPU3HaYeHHAM Ta He Y CMOXKMBYUNX LLNAX;

* MexXaHiYHi MOLUKOAKEHHS;

* MOLLKOAXKEHHS, O BUHUK/IN Y HACIAOK NMOTPanIsAHHA BCepeanHy BUPOBY CTOPOHHIX npes-
MeTiB, PEYOBWH, Pif1H, KOMaX;

* MOLLKOAXKEHHS, L0 BUKINKAHI CTUXIVHUMW InxaMu (AoLem, BiTpoM, 611cKaBKoO Ta
iH.), noXexeto, NobyToBMMM pakTopamu (HagMipHa BONOTICTb, 3aMuaeHiCcTb, arpecBHe
cepezioByLLe Ta iH.);

* MOLUKOAXEHHS, LLLO BUK/IMKaHI HEBIAMOBIAHICTHO NapaMeTpiB XXMUBAEHHS, KabesbHUX Mepex
Jep>KaBHUM CTaHZapTaMm Ta iHLWWX NOAIGHUX GpakTopiB;

* NPV NOPYLUEHHI M1OMO BCTaHOBNEHUX Ha BUPODi;

* BiZICyTHOCTi CepiiHOro Homepa NPUCTPOrD, a0 HEMOXJIMBOCTI OTO iAeHTUdIKYBaTW.

7. TepMiH rapaHTiiHOro o6cyroByBaHHsA cknazae 36 MicALiB 3 AHA NPOAAXY.

* BiApMBHi Ta/IOHN Ha TexHiYHe 06Cl'|yI'OByBaHH$I HaZakoTbCA aBTOPU3OBaHUM CepBiCHMM LLEHTPOM.

KomMnnekTHicTb BUpoby nepeBipeHo. I3 ymoBaMu rapaHTiiHOro 06cnyroByBaHHs
03HallOMJIEHUI, NPETEH3iN He Mato.

Mignuc nokynusa

ABTOopu3soBaHuii cepBicHuii yeHTp IM «I-AP-Cl»

Appeca: Byn. Mapka BoBuka, 18-A, Kuis, 04073, YkpaiHa
Ten.: 0 800 300 345; (044) 230 34 84; 390 55 12
www.erc.ua/service
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YCNOBUA TAPAHTUMHOIO OBCNY)XUBAHUA

YBarkaembivi Mokynartens! MosgpaBnaem Bac c npuobpereHnem nsge-
nusa 2E, kotopoe 6b110 pa3paboTaHO N U3roTOB/IEHO B COOTBETCTBUU

C CaMbIMM BbICOKMMM CTaHAAapPTaMM KauyecTBa.

Mpocum Bac coxpaHATb TaJIOH B TeUeHMe rapaHTuiiHoro nepuogaa. Mpwm
Nokyrmnke Usaenuva Tpebyiite NoONHOro 3anoJIHEHUA rapaHTUIHOIO Ta/loHa.

1. FapaHTUHOE 06CNYXKMBaHME OCYLLECTBAAETCS TObKO NMPW HaMUMKW MPaBUIBHO U YETKO 3arnon-
HEHHOro OPUrMHaNbLHOTO raPaHTUIAHOIO TalloHa, B KOTOPOM yKasaHbl: MOZAe/b N34enus, jata
NPOAAXM, CEPUIHbIN HOMEP, CPOK FaPaHTUMHOrO 06CAYXKMBaHWSA, 1 NevaT GUpMbI-NpoaasLa. *

2. Cpok cnyx6bl n3genmns coctaaset 60 MecsLeB.

3. VI3genvie npejHa3HayeHo Ans UCMO/b30BaHUsA B NOTpebuTenbckmx Lensx. Mpu ncnoab3osaHum
V3enns B KOMMEPUECKON AesTeNbHOCTM NPOoAaBeL,/MPoV3BOANTENb He HECET rapaHTUMHbIX
0653aTeNbCTB, CEPBUCHOE 0BCNYXKMBAHKE BbINOAHAETCA Ha NAAaTHOW OCHOBeE.

4. TapaHTUNHBIA PEMOHT BbIMNOJHAETCS B TEUEHME CPOKa, YKa3aHHOrO B rapaHTUIMHOM TaJIoHe Ha
n3genvie, B ynoJHOMOYEHHOM CEPBUCHOM LIEHTPE Ha YCNOBUSAX U B CPOKW, OMNpeaeneHHble fei-
CTBYHOLLMM 3aKOHOZATE/IbCTBOM.

5. i3genve cHMMaeTcs ¢ rapaHTvn B Clydae HapyLleHus noTpebutenem npasw aKCryaTaumm,
N3/I0XKEHHBIX B MHCTPYKLMW.

6. N3genve cHUMaeTCs ¢ rapaHTUMHOIO OBCNY>XKMBAHWSA B CEAYHOLLMX CyYasiX:

MCMO/b30BaHME He MO HazHaUYeHWHO U He BO MOTPEOUTENBCKUX LENsX;

MexaH14eckne NoBpexXAeHUs;

NOBPEXAEHWs, BOHUKLLIVE BCeCTBYE NOMajaHNs BHYTPb U3AeNnNs NOCTOPOHHUX Mpes-

METOB, BELLECTB, >XMAKOCTEeN, HACEKOMbIX;

NOBPEXAEHWS, Bbl3BaHHbIE CTUXMNHBIMU BeACTBUAMM (LOXKAEM, BETPOM, MOHWEN 1 Np.),

no><apom, 6bIToBbIMK GakTopaMm (Ype3mepHas BAAKHOCTb, 3arblIEHHOCTb, arpeccMBHas

cpesa v np.)

NMOBPEXAEHWS, BbI3BaHHbIE HECOOTBETCTBMEM MapaMeTPOB NUTaHUS, KabenbHbIX ceTeit

rocyapCTBEHHbIM CTaHAapTaM U ApYrvx NoobHbIX GakTopos;

NPV HapyLUEHUW NAOMB, YCTaHOBNEHHbIX Ha U3Aenuu;

* OTCYTCTBUE CEPUINHOTO HOMEpa YCTPOMCTBA, NV HEBO3MOXXHOCTN €ro MAEHTUPULMPOBATD.

7. CpoK rapaHTUIHOro 06C/y>KnMBaHWs cocTaBaseT 36 MecALEeB CO AHA NMPOAAXM

* OprIBHbIe Ta/IOHbl Ha TeXHMU4YecKoe oécnyxmsaHme npeaocTaBiAOTCA aBTOPU3OBaHHbLIM CEPBUCHBIM LIEHTPOM.

Komnnekrtauuto nsgenva nposepeHo. C yc1oBUAMU rapaHTUIAHOFO 06CayXu-
BaHWA O3HAKOMJIEH, MPETEH3UN HeT.

nOp,I'II/ICb nokynartens
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Warranty card/lFapaHTinHuin TanoH/fapaHTUIHDbIN TanoH

Product information/IHpopmaLiis npo Bupi6/MHpopmauus o6 nsgennn

Product/Bupi6/V3genve

Model/Mogenb

Serial number/Cepiittuit Homep/CepwiiHbil HoMep

Seller Information/IHpopmaLis npo npoaasus/VHdopmaLus o npogasLe

Trade organization name/Ha3Ba ToproBoi opraHizaLlii/Ha3BaHue Toprosoii opraHusaLmu

The address/Aapeca/Aapec

Date of sale//lata npoaaxy//lata npogaxw

Seller stamp/LUtamn npogasus/LLtamn npoaasua

Coupon/TanoH N2 3

Seller stamp/

Lramn npogasus/ —
Date of application/[lata 3BepHeHHs/[aTa obpalleHus

LUramn npoaaBua

Cause of damage/MpuunHa nowkogxKeHHs/MNprurHa noBpexaeHns

Date of completion//flata BukoHaHHs//laTa BbINOAHEHNS

Coupon/TanoH N2 2

Seller stamp/

LWrtamn npoaasus/ —
Date of application//lata 3BepHeHHs//aTa obpalleHns

LUtamn npogasua

Cause of damage/MpuunHa nowkogxxeHHs/MprurHa noBpexaeHns

Date of completion/[lata BUKOHaHHs/[laTa BbINOAHEHWS

Coupon/TanoH N2 1

Seller stamp/

Lramn npogasus/ —
Date of application/[lata 3BepHeHHs/aTa obpalleHus

LUramn npoaasua

Cause of damage/MpuunHa nowkogxKeHHs/MNpryrHa noBpexaeHns

Date of completion//[lata BukoHaHHs//laTa BbINOAHEHNS






